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Notices 
BioTek® Instruments, Inc. 
Highland Park, P.O. Box 998 
Winooski, Vermont 05404-0998 USA 

All Rights Reserved 

© 2015, BioTek® Instruments, Incorporated. No part of this publication may be reproduced, 
transcribed, or transmitted in any form, or by any means electronic or mechanical, including 
photocopying and recording, for any purpose other than the purchaser’s use without written 
permission of BioTek Instruments, Inc. 

Trademarks 

BioTek® is a registered trademark, and Cytation™, Gen5™, BioStack™, and Take3™ are 
trademarks of BioTek Instruments, Inc. Glowell™ is a trademark of LUX Biotechnology, Ltd. 
Harta™ is a trademark of Harta Instruments. 
Microsoft®, Windows®, and Excel® are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. 
  
All other trademarks are the property of their respective holders. 

Restrictions and Liabilities 

Information in this document is subject to change and does not represent a commitment by 
BioTek Instruments, Inc. Changes made to the information in this document will be incorporated 
in new editions of the publication. No responsibility is assumed by BioTek for the use or 
reliability of software or equipment that is not supplied by BioTek or its affiliated dealers. 
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Contact Information 

Customer Service and Sales 

Internet: www.biotek.com 
Phone: 888-451-5171 (toll-free in the U.S.) 
  802-655-4740 (outside the U.S.) 
Fax: 802-655-7941 
Email: customercare@biotek.com 

Global Service and Support 

BioTek instrument service and repair is available worldwide at one of BioTek's 
International Service Centers and in the field at your location. For technical 
assistance, contact the Technical Assistance Center (TAC) at BioTek US—World 
Headquarters. To arrange for service or repair of your instrument, contact the office 
nearest you. 

BioTek US—World Headquarters BioTek China—Beijing 

Phone: (802)655-4740 
Toll-Free: (888)451-5171 
Service Toll-Free: (800)242-4685 
Email: CustomerCare@biotek.com 
Service Email: TAC@biotek.com 
www.biotek.com 

Phone: +86 (10) 85865569 
Email: infochina@biotek.com 
Website: www.biotekchina.com.cn 

BioTek China—Shanghai BioTek France 

Phone: +86 (021)50435800 
Email: infochina@biotek.com 
Website: www.biotekchina.com.cn 

Phone: +33 (3) 89206329 
Email: info@biotek.fr 
Website: www.biotek.fr 

BioTek Germany—European 
Coordination Center 

BioTek India 

Phone: +49 (0) 71369680 
Email: info@biotek.de 
Website: www.biotek.de 

Phone: +91 (22) 66870046 
Fax: +91 (22) 28759944 
Email: biotek@biotek.in 
Website: www.biotek.in 

BioTek Japan BioTek Singapore 

Phone: +81(0)3 5812 8109 
Email: infojapan@biotek.com 
Website: www.biotek.com/ja 

Phone: +65 65922100 
Email: singapore@biotek.com 
Website: www.biotek.com 
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BioTek South Korea BioTek Switzerland 

Phone: +82 (0) 2 5624740 
Email: korea@biotek.com 
Website: 
www.biotekinstruments.co.kr 

Phone: +41 (41) 2504060 
Email: info@biotek.ch 
Website: www.biotek.ch 

BioTek Taiwan BioTek United Kingdom (UK) 

Phone: +886(2)26277725 
Email: infotaiwan@biotek.com 
Website: www.biotek.com 

Email: CustomerCare@biotek.com 
Website: www.biotek.uk.com 

Instructions for Use Requirements 
This document fulfills the basic needs of persons operating this device, according to 
the requirements of the In Vitro Diagnostic Directive for "Instructions for Use." Some 
of the device's higher-level functions and features, as well as certain detailed 
maintenance and qualification routines, are described in the Cytation 5 Operator's 
Manual. 

Intended Use Statement 
The Cytation 5 is a hybrid multi-mode microplate reader. The performance 
characteristics of the data reduction software have not been established with any 
laboratory diagnostic assay. The user must evaluate this instrument and PC-based 
software in conjunction with their specific assay(s). This evaluation must include the 
confirmation that performance characteristics for the specific assay(s) are met. 

• If the instrument has an "IVD" label, it may be used for clinical and non-clinical 
purposes, including research and development. If there is no such label, the 
instrument may be used only for research and development or other non-
clinical purposes. 

Quality Control 
It is considered good laboratory practice to run laboratory samples according to 
instructions and specific recommendations included in the assay package insert for 
the test to be conducted. Failure to conduct Quality Control checks could result in 
erroneous test data. 
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Warnings 

 

Operate the instrument on a level, stable surface away from excessive 
humidity. 

  Bright sunlight or strong incandescent light can reduce the linear 
performance range of the instrument. 

  Measurement values may be affected by extraneous particles (such as dust) 
in the microplate wells. A clean work area is necessary to ensure accurate 
readings. 

  When operated in a safe environment according to the instructions in this 
document, there are no known hazards associated with the instrument. 
However, the operator should be aware of certain situations that could result 
in serious injury; these may vary depending on the instrument model. See 
Hazards and Precautions. 

Hazards 
The following hazards are provided to help avoid injury: 

 

Warning! Power Rating. The instrument’s power supply or power 
cord must be connected to a power receptacle that provides voltage 
and current within the specified rating for the system. Use of an 
incompatible power receptacle may produce electrical shock and fire 
hazards. 

  Warning! Electrical Grounding. Never use a plug adapter to connect 
primary power to the external power supply. Use of an adapter 
disconnects the utility ground, creating a severe shock hazard. Always 
connect the power cord directly to an appropriate receptacle with a 
functional ground. 

  Warning! Service. Only qualified technical personnel should perform 
service procedures on internal components. 

  Warning! Accessories. Only accessories that meet the 
manufacturer's specifications shall be used with the instrument. 

  Warning! Lubricants. Do not apply lubricants to the microplate 
carrier or carrier track. Lubricant on the carrier mechanism or 
components in the carrier compartment will attract dust and other 
particles, which may obstruct the carrier path and cause the instrument 
to produce an error. 

  Warning! The instrument with all available modules weighs up to 80 
lbs. (36.3 kg). Use two people when lifting and carrying the 
instrument. 

  Warning! Liquids. Avoid spilling liquids on the instrument; fluid 
seepage into internal components creates a potential for shock hazard. 
If a spill occurs while a program is running, abort the program and turn 
off the instrument. Wipe up all spills immediately. Do not operate the 
instrument if internal components have been exposed to fluid. Contact 
BioTek TAC for assistance. 
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  Warning! Unspecified Use. Failure to operate the equipment 
according to the guidelines and safeguards specified in this manual 
could result in a hazardous condition. 

  Warning! Software Quality Control. The operator must follow the 
manufacturer’s assay package insert when modifying software 
parameters and establishing reading methods. Failure to conduct 
quality control checks could result in erroneous test data. 

  Warning! Reader Data Reduction Protocol. No limits are applied to 
the raw measurement data. All information exported via computer 
control must be thoroughly analyzed by the operator. 

 

Warning! Internal Voltage. Always turn off the power switch and 
unplug the power supply before cleaning the outer surface of the 
instrument or removing its top case.  

 

Warning! Potential Biohazards. Some assays or specimens may 
pose a biohazard. This hazard is noted by the symbol shown here. 
Adequate safety precautions should be taken as outlined in the assay’s 
package insert. Always wear safety glasses and appropriate protective 
equipment, such as chemical-resistant rubber gloves and apron.  

 

 

Warning! LED Lights. Serious eye injury may occur if you stare 
directly at the LED during operation of the light. This hazard is noted by 
the symbol shown here.  

 

Warning! Pinch Hazard. Some areas of the dispense module can 
present pinch hazards when the instrument is operating. The module is 
marked with the symbol shown here. Keep hands/fingers clear of these 
areas when the instrument is operating.  

Precautions 
The following precautions are provided to help avoid damage to the instrument: 

 

Caution: Service. The instrument should be serviced by BioTek-
authorized service personnel. Only qualified technical personnel should 
perform service procedures on internal components. 

  Caution: Spare Parts. Only approved spare parts should be used for 
maintenance. The use of unapproved spare parts and accessories may 
result in a loss of warranty and potentially impair instrument performance 
or cause damage to the instrument. 

  Caution: Environmental Conditions. Do not expose the system to 
temperature extremes. For proper operation, ambient temperatures should 
remain within the range listed in the Specifications chapter. Performance 
may be adversely affected if temperatures fluctuate above or below this 
range. Storage temperature limits are broader. 
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  Caution: Sodium Hypochlorite. Do not expose any part of the 
instrument to the recommended diluted sodium hypochlorite solution 
(bleach) for more than 20 minutes. Prolonged contact may damage the 
instrument surfaces. Be certain to rinse and thoroughly wipe all surfaces.  

  Caution: Power Supply. Use only the power supply shipped with the 
instrument. Operate this power supply within the range of line voltages 
listed on it. 

  Caution: Disposal. Dispose of the instrument according to Directive 
2012/19/EC, “on waste electrical and electronic equipment (WEEE)” or 
local ordinances. 

  Caution: Warranty. Failure to follow preventive maintenance protocols 
may void the warranty. See the Maintenance chapter. 

  Caution: Shipping Hardware. The shipping brackets must be removed 
before operating the instrument. They must be reinstalled before shipping 
the instrument. See the Installation chapter. 

  Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the 
user’s responsibility to ensure that a compatible electromagnetic 
environment for this instrument is provided and maintained in order that 
the device will perform as intended. 

  Caution: Electromagnetic Compatibility. Do not use this device in 
close proximity to sources of strong electromagnetic radiation (e.g., 
unshielded intentional RF sources), because these may interfere with the 
proper operation. 
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CE Mark 

 

Based on the testing described below and information 
contained herein, this instrument bears the CE mark 

Refer to the Declaration of Conformity for specific details. 

Directive 2014/30/EU: Electromagnetic Compatibility 

Emissions—Class A 

The system has been type-tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1: Class A for Radiated Emissions 
and Line Conducted Emissions.  

Verification of compliance was conducted to the limits and methods of EN 55011 – 
(CISPR 11) Class A. In a domestic environment it may cause radio interference, in 
which case you may need to mitigate the interference. 

Immunity 

The system has been type-tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity. 
Verification of compliance was conducted to the limits and methods of the following: 

EN 61000-4-2, Electrostatic Discharge 
EN 61000-4-3, Radiated EM Fields 
EN 61000-4-4, Electrical Fast Transient/Burst 
EN 61000-4-5, Surge Immunity 
EN 61000-4-6, Conducted Disturbances from RFI 
EN 61000-4-8, Power Frequency Magnetic Field Immunity Test 
EN 61000-4-11, Voltage Dips, Short Interruptions and Variations 

Directive 2014/35/EU Low Voltage (Safety) 

The system has been type-tested by an independent testing laboratory and was 
found to meet the requirements of this Directive. Verification of compliance was 
conducted to the limits and methods of the following: 

EN 61010-1. "Safety requirement for electrical equipment for measurement, control 
and laboratory use. Part 1, General requirements." 
EN 61010-2-081. “Particular requirements for automatic and semi-automatic 
laboratory equipment for analysis and other purposes.” 
EN 61010-2-010. “Particular requirements for laboratory equipment for the heating of 
materials.“ 
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EN 60825-1, "Safety of laser products. Part 1: Equipment classification and 
requirements." 

Directive 2012/19/EU: Waste Electrical and Electronic 
Equipment 

Disposal Notice: Dispose of the instrument according to Directive 2002/96/EC, “on 
waste electrical and electronic equipment (WEEE)” or local ordinances. 

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this 
use) 

• Product registration with competent authorities 
• EN 61010-2-101. “Particular requirements for in vitro diagnostic (IVD) medical 

equipment.” 
• Traceability to the U.S. National Institute of Standards and Technology (NIST). 

Electromagnetic Interference and Susceptibility 

USA FCC CLASS A 

RADIO AND TELEVISION INTERFERENCE 

NOTE: This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance 
with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause 
harmful interference, in which case the user will be required to correct the 
interference at their own expense. 

In order to maintain compliance with FCC regulations, shielded cables must be used 
with this equipment. Operation with non-approved equipment or unshielded cables 
is likely to result in interference to radio and television reception. 

Canadian Department of Communications Class A 

This digital apparatus does not exceed Class A limits for radio emissions from digital 
apparatus set out in the Radio Interference Regulations of the Canadians Department 
of Communications. 

Le present appareil numerique n'emet pas du bruits radioelectriques depassant les limites 
applicables aux appareils numerique de la Class A prescrites dans le Reglement sur le 
brouillage radioelectrique edicte par le ministere des Communications du Canada. 
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User Safety 
This device has been type-tested by an independent laboratory and found to meet the 
requirements of the following: 

• Underwriters Laboratories UL 61010-1, “Safety requirements for electrical 
equipment for measurement, control and laboratory use; Part 1: General 
requirements.” 

• Canadian Standards Association CAN/CSA C22.2 No. 61010-1, “Safety 
requirements for electrical equipment for measurement, control and laboratory 
use; Part 1: General requirements.” 

• EN 61010 Standards, see CE Mark starting on page viii. 
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Safety Symbols 

Some of the following symbols may appear on the instrument or accessories: 

 

 Alternating current 
Courant alternatif 
Wechselstrom 
Corriente alterna 
Corrente alternata 

 

 

Warning, risk of crushing or 
pinching 
Attention, risque d'écrasement et 
pincement 
Warnen, Gefahr des Zerquetschens 
und Klemmen 
Precaución, riesgo del 
machacamiento y sejeción 
Attenzione, rischio di schiacciare ed 
intrappolarsi 

 Direct current 
Courant continu 
Gleichstrom 
Corriente continua 
Corrente continua 

 

Warning, hot surface 
Attention, surface chaude 
Vorsicht, heiße Oberfläche 
Precaución, superficie caliente 
Attenzione, superfice calda 

 
Both direct and alternating 
current 
Courant continu et courant 
alternatif 
Gleich - und Wechselstrom 
Corriente continua y 
corriente alterna 
Corrente continua e corrente 
alternata 

 

 

Laser radiation: Do not stare into 
beam 
Rayonnement laser: Ne pas 
regarder dans le faisceau 
Laserstrahlung: nicht in den strahl 
blicken 
Radiación de laser: No mire 
fijamente al rayo 
Radiazione di laser: Non stare nel 
fascio 

 

Earth ground terminal 
Borne de terre 
Erde (Betriebserde) 
Borne de tierra 
Terra (di funzionamento) 

 

Warning, potential biohazards 
Attention, risques biologiques 
potentiels 
Warnung! Moegliche biologische 
Giftsoffe 
Atención, riesgos biológicos 
Attenziones, rischio biologico 

 

Protective conductor 
terminal 
Borne de terre de protection 
Schultzleiteranschluss 
Borne de tierra de 
protección 
Terra di protezione 

 

Caution (refer to accompanying 
documents) 
Attention (voir documents 
d'accompanement) 
Achtung siehe Begleitpapiere 
Atención (vease los documentos 
incluidos) 
Attenzione, consultare la doc 
annessa 

Cytation 5  



xii | Preface 

 

On (Supply) 
Marche (alimentation) 
Ein (Verbindung mit dem 
Netz) 
Conectado 
Chiuso 

 
Consult instructions for use 
Consulter la notice d'emploi 
Gebrauchsanweisung beachten 
Consultar las instrucciones de uso 
Consultare le istruzioni per uso 

 
Off (Supply) 
Arrêt (alimentation) 
Aus (Trennung vom Netz) 
Desconectado 
Aperto (sconnessione dalla 
rete di alimentazione) 

 
In vitro diagnostic medical device 
Dispositif médical de diagnostic in 
vitro 
Medizinisches In-Vitro 
Diagnostikum 
Dispositivo médico de diagnóstico 
in vitro 
Dispositivo medico diagnostico in 
vitro 

 

Warning, risk of electric 
shock 
Attention, risque de choc 
électrique 
Gefährliche elektrische 
schlag 
Precaución, riesgo de 
sacudida eléctrica 
Attenzione, rischio di scossa 
elettrica 

 
Separate collection for electrical 
and electronic equipment 
Les équipements électriques et 
électroniques font l'objet d'une 
collecte sélective 
Getrennte Sammlung von Elektro- 
und Elektronikgeräten 
Recogida selectiva de aparatos 
eléctricos y electrónicos 
Raccolta separata delle 
apparecchiature elettriche ed 
elettroniche 
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Package Contents 
Item Part # 

Cytation 5 Operator's Manual (delivered on USB flash 
drive) 1321000 

Power cord set (specific to installation environment): 

Europe (Schuko) 

USA/International 

United Kingdom 

Australia/New Zealand 

  

75010 

75011 

75012 

75013 

USB cable 75108 

#2 Phillips screwdriver 01188 

9/64" hex wrench 01623 

Models with the imaging module: 

FireWire desktop interface  

OR 

FireWire laptop card and power supply 

  

01604 

 
1220535  
Power supply only: 
01062 

FireWire cable 1220538 

Microplate slide holder 1220548 

Isolation table 1220521 

Objective adapter collar wrench 1222187 

Objective setup plate 1222531 

3/32" hex wrench 48570 

Models with an external dispense module (packed separately), with the following 
accessories: 

Injector 8040541 

Inlet tubes (2) from supply bottles to syringe drives 7082121 

250-µL syringes (2) 7083000 

BioTek Instruments, Inc. 
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Item Part # 

Syringe thumbscrews 19511 

Priming plate 8042202 

Injector tip priming trough 8042068 

Dispense module communication cable 75107 

Dispense module front cover 8042197 

Dispense module box 8040534 

Supply bottles (2, 30 mL) 7122609 

Supply bottle holders (2) 8042193 

Injector tip cleaning stylus and plastic storage bag 2872304 

Strap reagent racks (6) 7212035 

Models with the gas controller ("G" models)(packed separately): 

Gas controller unit, CO2/O2 control 1210500 

Shipping accessories, CO2/O2 control 1210010 

Gas Controller Unit, CO2 only 1210504 

Shipping accessories, CO2 only 1210009 

1: Unpack and Inspect the Reader 

 

The Cytation 5 should be removed from the box by two people. The instrument 
with all available modules weighs up to 80 pounds (36.6 kg). 

Save all packaging materials. If you need to ship the reader to BioTek for repair 
or replacement, you must use the original materials. Using other forms of 
commercially available packaging, or failing to follow the repackaging 
instructions, may void your warranty. 

During the unpacking process, inspect the packaging, reader, and accessories 
for shipping damage. If the reader is damaged, notify the carrier and your 
BioTek representative. Keep the shipping boxes and the packaging materials 
for the carrier's inspection. BioTek will arrange for repair or replacement 
immediately. 

1. Open the shipping box, remove the instrument from the box, and place it on 
a level, stable surface. 

2. Place the packaging materials back into the shipping box for reuse if the 
instrument needs to be shipped again. 

3. For the instruments with the imaging module: Open the accessories box, and 
remove the isolation table.  
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2: Unpack and Inspect the Dispenser  
If applicable: 

1. Open the shipping box. Remove the accessories box and foam insert that 
contains the injector tubing and bottle holders. 

2. Lift out the dispenser and place it on a level surface. 
3. Open the accessories box and remove its contents.  
4. Place all packaging materials into the shipping box for reuse if the dispenser 

needs to be shipped. 

3: Unpack and Inspect the Gas Controller 
If applicable:  

1. Open the shipping box. Remove the accessories, and set them aside. 
2. Lift out the gas controller, and place it on a level surface. 
3. Place all packaging materials into the shipping box for reuse if the gas 

controller needs to be shipped. 

4: Select an Appropriate Location 
Install the reader on a level, stable surface in an area where ambient temperatures 
between 18°C (64°F) and 30°C (86°F) can be maintained.  

Leave at least six inches of space between the instrument’s rear panel and any other 
object. This space ensures proper air flow in and out of the instrument. 

The reader is sensitive to extreme environmental conditions. Avoid the following: 

• Excessive humidity. Condensation directly on the sensitive electronic circuits 
can cause the instrument to fail internal self-checks. The humidity must be in 
the range of 10–85%, non-condensing. 

• Excessive ambient light. Bright light may affect the reader’s optics and 
readings, reducing its linear range. 

• Dust. Readings may be affected by extraneous particles (such as dust) in the 
microplate wells. A clean work area is necessary to ensure accurate readings. 

• Vibration. The instrument should be installed in a vibration-free environment. 
Be sure to position the instrument away from other devices that could 
potentially create vibration during the read process. 

If you are installing a BioStack for operation with the Cytation 5, you may 
wish to seat the instruments in their alignment plates now. Refer to the 
stacker's operator's manual for more information. 
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Installing Instruments with the Isolation Table 

Cytation 5 models with the imaging module can be used with an isolation table, 
which helps to eliminate vibration during image reads. 

 
Do not use the isolation table when operating the Cytation 5 with a microplate 
stacker. Store the isolation table in a clean, dry location. 

1. Remove the four corner clips from the isolation table. 

 

2. Place the isolation table in the selected installation location. 
3. Place the instrument on the table as shown next: 
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The isolation table contains material that dampens vibration. Over time, this material 
becomes compressed and can lose effectiveness. The isolation table has a color 
indicator that turns from green to red to show when the table should be replaced 
because the dampening material has been compressed.  

 

5: Remove the Shipping Hardware 

 
Remove all shipping hardware before you turn on the reader. 

1. Locate the shipping hardware. 

The figures below depict a Cytation 5 with the filter module and imaging 
module. 
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2. Open the top door, and remove the reusable zip tie and desiccant packet 
from the desiccant anchor. 

3. If equipped, use the supplied screwdriver to remove the top filter shipping 
bracket. 

4. Open the front door, and using the supplied screwdriver, remove the carrier 
shipping bracket. 

5. If equipped with the imaging module, use a 9/64" hex wrench to remove the 
bottom filter slide ship bracket 

6. Push the filter slide back, and remove the two-piece objective ship bracket. 
7. Store the shipping hardware in a safe location, in case the instrument needs 

to be shipped again. 

6: Install the Power Supply 

 Power Rating. The instrument must be connected to a power receptacle that 
provides voltage and current within the specified rating for the system. Use of 
an incompatible power receptacle may produce electrical shock and fire 
hazards. 

Electrical Grounding. Never use a plug adapter to connect primary power to 
the instrument. Use of an adapter disconnects the utility ground, creating a 
severe shock hazard. Always connect the system power cord directly to an 
appropriate receptacle with a functional ground. 

1. Locate the power inlet on the back of the reader. 
2. Examine the power supply's plug. It has a small groove that lines up with a 

tab inside the power inlet. 
3. Insert the plug into the power inlet and plug the power supply's cord into an 

appropriate power receptacle.  
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Do not plug the power supply into a power receptacle until after the 
power supply is connected to the instrument. 

7: Install the Gas Controller (if applicable) 
The gas controller is an external module that enables the user to control CO2 and O2 
concentrations inside the attached instrument’s reading chamber. If you purchased 
the module for operation with the Cytation 5, refer to the Gas Controller User Guide 
for installation instructions. 

8: Unpack and Install the Joystick (if 
applicable) 

If applicable:  

1. Open the shipping box, lift out the joystick, and place it on a level surface. 
2. Place all packaging materials into the shipping box for reuse if the joystick 

needs to be shipped. 
3. Locate the joystick cable. Plug one end into the port on the back of the 

joystick. Plug the other end into the joystick port on the rear of the reader.  

9: Install the Dispenser 

Place the dispense module on top of the reader or on top of the gas 
controller (if equipped). Do not place the dispenser next to the reader. 
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1.  Open the plastic bag containing the injector tube and tips. Remove the clear 
plastic shrouds from the tubes. 

2. Remove the two inlet tubes from their plastic canisters. 
3. Identify the two syringe valves on the dispense module. Each is labeled with 

a left-pointing arrow. 

When installing the inlet and outlet tubes, do not use any tools. Finger-
tighten only! 

4. Screw the fitting of one inlet tube into the right side of the Syringe 1 valve. 
5. Identify the #1 outlet tube, and screw it into the left side of the Syringe 1 

valve. 
6. Repeat these steps to attach the inlet and outlet tubing for Syringe 2. 

It is critical that the tubing is installed in the correct ports. Otherwise, 
injected fluid may miss the intended well. 

7. Remove the round tubing feed-through cover from the top of the reader (2 
screws). Store the cover and screws with the shipping hardware in case the 
reader needs to be shipped again. 

8. Thread the injector tip holder, with outlet tubing connected to both ports, 
through the hole in the top of the reader. 

9. Open the reader's top door, and, holding the injector tip holder by the tab, 
insert the injector tips into the appropriate holes inside the reader.  

A magnet located between the injector tips helps to guide the tips into 
place and secures them in the reader. 

10. Place the tubing feed-through cover over the hole in the top of the reader and 
finger-tighten the thumbscrews to secure it. 

11. Remove the two syringes from their protective boxes. They are identical and 
interchangeable.  

12. Install both syringes. 
• Hold the syringe vertically with the threaded end at the top. 
• Screw the top of the syringe into the bottom of the syringe valve. Finger-

tighten only. 
• Carefully pull down the bottom of the syringe until it rests inside the hole 

in the bracket. 
• Pass a thumbscrew up through this hole and thread it into the bottom of 

the syringe. Hold the syringe to prevent it from rotating while tightening 
the thumbscrew. Finger-tighten only. 
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13. Locate the dispenser cable. Plug one end into the port on the left side of the 
dispenser. Plug the other end into the “Dispenser Port” on the rear of the 
reader. 

14. Locate the injector tip-cleaning stylus, packaged in a small cylinder. Attach 
the cylinder to the back of the dispenser for storage. 

10: Connect the Host Computer 
The Cytation 5 is equipped with a USB port for connection to the host computer. 
Connect the supplied USB cable between the USB port on the back of the reader and 
an available USB port on the computer. 

11: Install Gen5  

 

The Cytation 5 is controlled by Gen5 software running on a host computer. 
There is a certain sequence of events that must be followed to ensure that the 
software is properly installed and configured. Please follow the instructions 
provided in Gen5 Getting Started Guide to install the software. 

12: Turn on the Reader 
If you have not already done so, turn on the reader. The reader’s power switch is 
located on the lower-right corner of the front panel. The reader performs a system 
test. When the test is completed, the reader extends the microplate carrier.  

The carrier eject button, located above to the reader’s power switch, can 
be used to extend/retract the microplate carrier. 

13: Establish Communications 

Before performing this step, refer to the instructions that shipped with 
the USB Driver Software on the Gen5 software media to install the 
necessary drivers. 

1. If not already done, start Gen5 and log in if prompted. The default System 
Administrator password is admin. 

2. From the Gen5 main screen, select System > Instrument Configuration 
and click Add Reader. 

3. Set the Reader Type to Cytation 5, and click OK to continue. 
4. Select Plug & Play. 
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A Cytation 5 must be connected via USB to the computer and turned 
on to appear in the Available Plug & Play Readers list. 

5. To test that Gen5 can communicate with the instrument, click Test 
Communications. If the communication attempt is successful, Gen5 
displays a success message. Return to Gen5’s main screen. 

Communication Errors 

If the communication attempt is not successful, try the following: 

• Is the reader connected to the power supply and turned on? 
• Is the communication cable firmly attached to both the reader and the 

computer? 
• Did you select the correct Reader Type in Gen5? 
• Did you install the USB driver software? 

If you remain unable to get Gen5 and the reader to communicate with 
each other, contact BioTek’s Technical Assistance Center. 

14: Install the Imager Module 
Several steps are required to install the imager module. 

1. Install the FireWire card and driver 
2. Set up Gen5 for imaging 
3. Install the objectives, LED cubes, and imaging filter cubes, and run Auto 

Calibration 

Tools: 

• Screwdriver: Desktop computer users typically need a screwdriver to install the 
FireWire card. 

• 3/32" hex (or Allen) wrench 

1. FireWire Video Card: Computer and Camera Setup 

BioTek supplies the required FireWire card (PCI Express Card-IEEE-1394b) for either 
a desktop computer or a laptop. Follow the applicable instructions for your 
workplace, then install the FireWire software driver on your computer. 
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Desktop Computer: Install the FireWire Card 

To avoid electrostatic discharge and damage to internal components, 
ground yourself by using wrist grounding straps or by touching a metal 
surface on the computer's chassis. 

The following directions provide general steps for installing a PCI Express 
card. Talk to your company's IT representative for assistance with these 
steps. For more detailed help, contact BioTek TAC. 

1. Turn off your computer, then remove the outside case. Depending on the 
computer, remove either one side of the tower or the entire cover. 

2. Locate the PCI Express slot. Open the card retainer, and remove any existing 
graphics card (if necessary) or blank port located in the PCI Express slot. 

 

3. Insert the PCI Express card, aligning it with its slot. 
4. Press the card firmly into place, and secure the card with a locking rail or 

screws. 
5. Replace your computer's outside case, then power on the computer. 
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Laptop Computer: Install the FireWire Card 

1. Remove the PCI Express port cover or any existing PCI Express card from 
your laptop. 

 

2. Touch a metal object to discharge any static electricity. 
3. Remove the PCI Express card from the packaging. 
4. Attach the spacer, if required, to the FireWire PCI Express card.  

The spacer does not fit tightly. Ensure that it does not fall off. 
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5. Insert the FireWire Express card, with the label facing up, into the 
appropriate slot on your laptop. 

6. Plug the power cord into the card, then plug the cord into a power outlet. 

 

Install the FireWire Driver 

You must install the PCI Express card before performing this step. 

1. Navigate to the Gen5 program files on your computer, for example, 
C:\Program Files\BioTek\Gen5 2.07. 
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2. Open the Firewire Drivers folder, and then open the folder appropriate for 
your computer: Windows_32 (for Windows 32-bit) or Windows_64 (for 
Windows 64-bit). 

3. In Windows 7 and higher, right-click InstallPGRDriver.bat and select Run 
as Administrator to run the driver installer. When the installer is finished, 
a message appears: "SUCCESS: Installed package <path to package>". If you 
do not see this message, contact BioTek TAC. 

4. After installing the FireWire driver, restart your computer. 
5. When the reboot process is complete, insert one end of the FireWire cable 

into the back of the reader, and insert the other end into the new port (in the 
card you installed) on your computer. 

Establish Communication with the Camera 

1. From the Gen5 main screen, select System > Instrument Configuration, 
select Cytation 5, and then click View/Modify. 

2. Click Camera Information. If communication is successful, Gen5 displays 
information about the camera. 

Troubleshooting Communication with the Camera 

• Have you established communication with the instrument first? 
• Did you install the FireWire software driver? 
• Is the FireWire cable installed? Is your laptop card plugged into an electrical 

outlet? 
• Is the LED light on the back of the reader lit up?  

• Red: Power to the camera from the FireWire card 
• Half-Red/Half-Green: Ready state 
• Green: Communicating/activity 
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2. Set Up Gen5 for Imaging 

Configuration information must be set before any optical components are installed. 
Use Gen5 to update the instrument's onboard settings. The LED cubes and imaging 
filter cubes must be installed with the reader off. Follow these installation steps in 
the order in which they are given.  

1. In Gen5, select System > Instrument Configuration > Cytation 5 > 
View/Modify > Setup. 

2. On the Imaging Configuration tab, input the objective and LED cube and 
imaging filter cube configurations (see 3a. Setting the Objective, LED Cube, 
and Imaging Filter Cube Configuration on page 17), then click Send 
Values.  

Click Access next to an objective position in the Objective 
Configuration area to lower the focusing system into the desired 
access position and to rotate the objective turret to the selected 
objective's installation position. 

3. Install the objectives (see 3b. Install the Objectives on page 17) in their 
defined locations. 

4. Power off the instrument, and install the LED cubes and imaging filter cubes 
(see 3c. Install the LED Cubes and Imaging Filter Cubes on page 17) in their 
defined locations. Close the side access door. 

Leave Gen5 open with the Reader Setup dialog onscreen while 
performing the next steps.  

5. Power on the instrument. After the self-test, the instrument will beep and the 
eject button LED will be red, indicating that the objectives must be 
calibrated. 

6. Press the carrier eject button to stop the beeping. 
7. Click Auto Calibration. Note that this process can take up to 15 minutes on 

an instrument with six objective installed. 

Phase contrast components are calibrated in the factory before shipment. 
You do not need to run the Phase Ring Configuration and Calibration 
routines at this time. 
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3a. Setting the Objective, LED Cube, and Imaging Filter Cube 
Configuration 

When you install an LED cube, an imaging filter cube, or an objective, you must set 
the cubes' and objectives' configuration before physically changing or installing 
them.  

If you physically install an LED cube, an imaging filter cube, or an 
objective before setting the new configuration, the instrument may fail its 
self-test. 

1. From the main Gen5 screen, click System > Instrument Configuration.  
2. Select the Cytation 5, click View/Modify > Setup, and select the 

Imaging Configuration tab. 
3. In the Objective Configuration area, select the objective for the position or 

positions you want to define, or select None if you are removing an 
objective from the instrument. Click Access. 

4. In the LED and Imaging Filter Cube Configuration area, select the filter cube 
for the position you want to define, or select None if you are removing the 
filter cube from the instrument. The corresponding LED cube part number is 
filled in automatically.  

5. Click Send Values.  
6. For LED cube and imaging filter cube changes, follow the on-screen 

procedure. 

3b. Install the Objectives 

Before installing a 20X, 40X, or 60X objective, either phase or standard, 
set its correction collar to match your plate type. See the Cytation 5 
Operator’s Manual for more information and instructions. 

After defining the objectives and their locations in Gen5: 

1. Turn the knob on the side access door to release the latch, and open the door. 
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If you are installing an objective with a correction collar (i.e., a 20X, 40X, or 
60X objective), be sure to grasp the objective by the adapter, not by the 
correction collar, to avoid changing the correction collar settings. 

2. Screw each objective into its defined position. Do not overtighten the 
objectives. 

3c. Install the LED Cubes and Imaging Filter Cubes 

1. With the instrument powered off, slide the filter slide out of the instrument. 

2. Place the new LED cube in the appropriate position (Position 1, 2, 3, or 4) on 
the filter slide.  

3. Use the 3/32" hex wrench to screw the LED cube onto the filter slide. 
4. Place the imaging filter cube on top of the LED cube you installed, and use 

the hex wrench to screw it to the LED cube.  
5. Insert the LED cube’s wire clip into the socket on the carrier. 
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6. Slide the filter slide back into the instrument. 
7. Close the side access door. 

Run Auto Calibration 

After you have physically installed the LED cubes, imaging filter cubes, and 
objectives, you must run Auto Calibration before you can use the imaging module. 
This process can take up to 15 minutes on an instrument with six objectives installed. 

1. Turn on your instrument, and allow the self-test to run. The instrument will 
beep, indicating that the self-test has failed. 

2. Press the carrier eject button to stop the beeping. 

3. If the Reader Setup dialog is not already visible on your screen, go to System 
> Instrument Configuration, select Cytation 5, then click View/Modify 
> Setup. 

4. On the Instrument Configuration tab, click Auto Calibration. 

5. If you have a 40X or 60X objective installed, Gen5 prompts you to place the 
objective setup plate (PN 1222531) on the carrier. After you place the setup 
plate on the carrier, click OK. 

After the calibration procedure is finished, the instrument is ready to use. 

Troubleshooting Auto Calibration 

If error messages indicate a problem with the imaging Auto Calibration process: 

1. In Gen5, click System > Instrument Configuration > Cytation 5 > 
View/Modify > Setup. 
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2. On the Imaging Configuration tab, set the value of all objectives to none, and 
then click Send Values. 

3. Set the correct values for all objectives, and then click Send Values. 

4. Click Auto Calibration. 

If problems persist, contact BioTek TAC. 

15: Configure the Dispensers in Gen5 
Before you use the dispenser with a BioTek reader, you must set the calibration 
values in Gen5.  

1. In Gen5, go to System > Instrument Configuration, select your 
instrument, and click View/Modify.  

2. Click Setup, and then select the Dispenser 1 tab.  
3. On the keyboard, press CTRL+SHIFT+M to enter maintenance mode for the 

Dispenser 1 window.  
4. Enter the syringe calibration values from the label on the rear of the 

dispenser box. (See Install the Dispenser.) 
5. Click Send Volumes, and then click Get Volumes to verify that the 

entered values were sent to the instrument.  
6. Select the Dispenser 2 tab, and repeat steps 3 through 5 for Dispenser 2.  
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16: Test the Dispenser 
1. If necessary, press the carrier eject button to extend the microplate carrier. 
2. Place the tip priming trough in the rear pocket of the carrier. 
3. Place the priming plate on the carrier. 
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4. Fill the two reagent bottles with distilled or deionized water. Place the bottles 
in their holders, and place the holders directly in front of the syringes. Insert 
the inlet tubes into the bottles. 

5. From the Gen5 main screen, select System > Instrument Control > 
Cytation 5. 

6. Click the Prime tab. 
7. With Dispenser set to 1, set the Volume to 5000 µL and click Prime. 

The syringe should move down and up repeatedly, drawing fluid from the 
bottle. The fluid should pump through the tubing and dispense into the 
priming plate. Examine the fittings; no leaks should be detected. If leaks are 
detected, tighten all fittings and repeat the prime. If leaks are still detected, 
contact BioTek’s Technical Assistance Center. 

8. When the prime finishes, set Volume to 2000 µL and click Purge to clear 
the fluid lines. 

9. Set Dispenser to 2 and repeat steps 7 and 8. 
10. When finished, remove and empty the priming plate. 
11. Return to the Gen5 main screen. 

17: Run a System Test 
Running a system test will confirm that the reader is set up and running properly, or 
will provide an error code if a problem is detected. 

1.  Turn on the incubator: 
• From the Gen5 main screen, select System > Instrument Control > 

Cytation 5. 
• Click the Pre-Heating tab. 
• Enter a Requested temperature of at least 37°C and click On. 

Wait until the incubator temperature reaches the set point before 
continuing. 

2. Return to Gen5's main view and select System > Diagnostics > Run 
System Test. If prompted to select a reader, select Cytation 5 and click 
OK. 

3. When the test is completed, a dialog requesting additional information 
appears. Enter the information and click OK. 

If a message appears that a pending system test is waiting from the 
initial power-up self-test, view the pending system test and repeat steps 
2 and 3. 
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4. The results report appears. Scroll down toward the bottom; the text should 
read “SYSTEM TEST PASS.” 
• You may wish to print the report and store it with your records. 
• The Gen5 software stores system test information in its database; you can 

retrieve it at any time. 
5. Turn off the incubator: 

• Select System > Instrument Control > Cytation 5. 
• Click the Pre-Heating tab and click Off. 

Repackaging and Shipping Instructions 
Refer to the Cytation 5 Operator’s Manual for complete instructions for 

repackaging and shipping the instrument and accessories. 

 

If the reader and/or dispenser has been exposed to potentially hazardous 
material, decontaminate it to minimize the risk to all who come in contact 
with the reader during shipping, handling, and servicing. Decontamination 
prior to shipping is required by the U.S Department of Transportation 
regulations. See the Maintenance chapter for decontamination instructions. 

Remove the microplate and tip prime trough (if equipped) from the carrier 
before shipment. Spilled fluids can contaminate the optics and damage the 
instrument. 

 

The instrument with all available modules weighs up to 80 lbs (36.3 kg). 
Use two people when lifting and carrying the instrument. 

 The instrument's packaging design is subject to change. If the instructions in 
this section do not appear to apply to the packaging materials you are using, 
please contact BioTek's Technical Assistance Center for guidance. 

Replace the shipping hardware before repackaging the reader. Please 
contact BioTek if you have misplaced any of these items. 

• Carrier ship bracket (PN 1220510) 
• Carrier ship bracket screws (PN 1032190) 
• Top filter shipping bracket (PN 8042187) 
• Bottom filter slide ship bracket (PN 1380501) 
• Objective ship bracket (PN 1380503) 

If you need to ship the Cytation 5 and/or the dispense module to BioTek for 
service or repair, be sure to use the original packaging materials. Other 
forms of commercially available packaging are not recommended and can 
void the warranty. The shipping materials are designed to be used no more 
than five times. If the original materials have been damaged, lost, or used 
more than five times, contact BioTek to order replacements. 
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Overview 
The Cytation 5 is a hybrid multi-mode microplate reader. Depending on the model, 
Cytation 5 detection modes include fluorescence intensity (FI), fluorescence 
polarization (FP), time-resolved fluorescence (TRF), luminescence, UV-visible 
absorbance, imaging, and alpha. The instrument is modular, and upgrade options are 
available; contact BioTek Customer Care for more information. 

The reader is computer-controlled using Gen5 software for all operations, including 
data reduction and analysis. The Cytation 5 is robot accessible and compatible with 
the BioStack 3 and BioStack 4. Gen5 supports OLE automation to facilitate the 
Cytation 5’s integration into an automated system. 

Refer to the Gen5 Help system for operational and data analysis 
instructions. 

The Cytation 5 Operator's Manual contains recommendations for ensuring 
optimum performance. 

External Components 

 
 

1 The entry for the dispense outlet tubes and injectors (if equipped) 
2 Filter cube access door 
3 The microplate carrier eject button 
4 The light-blocking microplate carrier access door 
5 The power switch  
6 LED cubes, imaging filter cubes, and objectives access door 
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1 Dispenser port 
2 Joystick port 
3 USB port 
4 Power inlet 
5 Gas controller hookup 
6 FireWire port 

Internal Components 
Component Description 

Filter Cube 

The filter cube can contain excitation and emission filters, mirrors, 
and polarizing filters. Preconfigured cubes are available from BioTek, 
or you can change the filters and mirrors yourself. 

Note: These cubes are not to be confused with the imaging 
LED cubes and filter cubes. 

Injector 
System 

Applies to models with the dispense module. The syringes may 
require replacement over time. The tubing and injectors require 
cleaning at regular intervals.  

Imaging 
System 

Applies to models with the imaging module. The imaging system, 
comprising a CCD camera, objectives, LED cubes, and filter cubes, 
allows you to run experiments with imaging reads as well as view 
images in live mode. 
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Filter Cube 

The Cytation 5 is equipped with a filter cube that contains excitation and emission 
filters, mirrors, and, if required, polarizing filters. Each filter cube contains two filter 
sets, each of which contains one excitation filter, one mirror, and one emission filter. 
The filter cube is accessed through a hinged door on the front of the instrument. 

Synergy H1 filter cubes are interchangeable with the filter cubes for the 
Cytation 5.  

Do not open the door to access the filter cube during instrument 
operation. Doing so may result in invalid data. 

Define the Filters 

Gen5 keeps track of each cube's contents and communicates this information to the 
instrument during operation. You must define characteristics for your filter cube(s) in 
the Gen5 Filter Cube Table (System > Instrument Configuration > Setup). 

• Select Band Pass, Long Pass, or Short Pass, as appropriate for each filter 
type. 
• Band Pass, a standard interference filter with a defined central wavelength 

and bandwidth. 
• Long Pass, cutoff filters that transmit longer wavelengths and block shorter 

wavelengths. 
• Short Pass, cutoff filters that transmit shorter wavelengths and block longer 

wavelengths. 
• Select PLUG to indicate the presence of a plug. 
• Select HOLE to indicate an empty location. 

Configuring the System for Luminescence Measurements 

If your tests require that light emitted from the samples remain unfiltered, the 
Emission filter position in the filter cube should be empty. 

1. Click System > Optics Library > Filter Cubes. 
2. Select the checkbox in the On Site column for the filter cubes you have 

available.  

Injector System 

The tubing and injectors should be cleaned at least every three months. 

 Inspect the injector system daily for leaks, preferably immediately after 
priming and whenever tubing changes have been made. 
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If a syringe is leaking, it may need to be replaced.  

Dispense Module 

The dispense module sits on top of the reader or gas controller and pumps fluid from 
the reagent bottles to injector located inside the instrument. Fluid is injected into one 
well at a time. The injectors support plate types from 6- to 384-well plates. 

 

 
1 Two 250 µL syringes draw fluid from the supply bottles 
2 Inlet tubes transport fluid from the supply bottles to the 

syringes. These tubes are short pieces of opaque PTFE 
(Teflon) tubing connected to stainless-steel probes on 
one end and threaded fittings on the other end. 

3 Solenoid valves allow the fluid drawn from the supply 
bottles by the syringe pumps to flow into the outlet 
tubes. 

4 Outlet tubes transport fluid from the syringes into the 
instrument, through the tubing ports on the Cytation 5's 
top cover. The outlet tubes are opaque PTFE tubes with 
threaded fittings on each end. 

Dispense Module Components and Materials Composition 

Continuous contact with harsh chemicals is not recommended. Always rinse the 
fluid path with deionized water after contact with any strong acid, base, or solvent. 
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Components Material Composition 

Tubing, syringe fittings PTFE (polytetrafluoroethylene) 
Injector tips 315 stainless steel 
Injector body PVC (polyvinyl chloride) 
Priming plate and trough Polyproylene 
Valve diaphragms Ethylene propylene (EPDM) 
Valve body PEEK (polyether ether ketone) 
Syringe barrel Borosilicate glass 

Priming the Injector System 

Before running a dispense assay, prime the system with the reagent or dispensing 
fluid. In addition, tip priming can be performed at the start of an assay and, 
sometimes, just before each dispense to a well. The tip prime compensates for any 
fluid loss at the injector tip due to evaporation since the last dispense. All priming 
activities are controlled via Gen5. 

If the injector system is not primed adequately, air bubbles can get 
trapped in the system and affect injection volumes. Air bubbles in the 
system can also result in fluid spraying or scattering inside the reader. 

Both types of primes require a fluid reservoir to be present on the microplate carrier. 

• The priming plate is placed on the microplate carrier for a Prime operation (to 
prime the dispense system with fluid). 

• The tip priming trough is placed in the rear pocket of the carrier, and is used for 
performing the Tip Prime before dispensing. The trough holds up to 1.5 mL of 
liquid and must be periodically emptied and cleaned by the user. 

Do not perform tip priming when using tall plates. Generally, plates 
with fewer than 96 wells are too tall for error-free tip priming; and, tip 
priming is rarely required for these larger-volume plates. 

The priming tray should be empty before priming and contain fluid after 
priming. 

Imaging System 

Instruments with the imaging module can perform image reads, view and capture 
images in manual mode, and save the images for later analysis. The imaging module 
comprises up to four LED cubes and four imaging filter cubes, up to six objectives, 
and a CCD digital camera, which captures images directly through the selected 
objective and filter cube assembly. The imaging module supports two modes, 
manual mode and experiment mode. 
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Camera 

Gen5 controls the CCD camera via FireWire. Using Gen5, you can focus the camera, 
determine exposure settings, and capture images. 

LED Cubes and Imaging Filter Cubes 

The LED cubes and imaging filter cubes are located behind a door on the left side of 
the instrument and are user-changeable.  

Objectives 

The objectives are located next to the LED cubes and imaging filter cubes in an 
objective turret. Gen5 supports the installation of up to six user-changeable 
objectives.  

Imaging Modes 

The Gen5 imaging module provides two modes of use: manual and experiment.  

• Manual mode allows you to view, capture, and analyze images outside of a 
protocol or experiment. Images are displayed in real time. You can also retrieve 
previously captured and saved images to analyze in manual mode.  

• In experiment mode, you can perform an image read step as an endpoint read 
or include it in a kinetic block in your procedures and experiments. An imaging 
procedure can include additional steps (as supported by the reader), such as 
dispense, shake, incubate, and different detection modes. 

Change the Virtual Memory Settings 

You may find that you need more hard disk space than is allocated by default. For 
example, running a multiplate experiment, imaging all 96 wells in a 4x4 montage in 
three colors will require an increase of virtual memory. Without this change, the 
message, “This procedure may require that you increase the size of the virtual 
memory in Windows,” may appear. In this case, please consult with your IT group to 
increase virtual memory, using the following instructions to prevent errors: 

1. From the Windows Start menu, go to Control Panel and select System. 
2. In the left pane, select Advanced system settings. 
3. In the System Properties dialog, on the Advanced tab in the Performance area, 

click Settings. 
4. In the Performance Options dialog, on the Advanced tab, in the Virtual Memory 

area, click Change. 
5. Clear Automatically manage paging file size for all drives, if it is selected. 
6. Select Custom Size, enter the following minimum and maximum values, and 

then click OK: 
• Initial size: 10 GB 
• Maximum size: 20 GB 
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You may need to restart your computer for the change to take effect. 

Shaking System 
Three shake modes are available for selection in Gen5: Linear, Orbital, and Double 
Orbital. A linear shake simply moves the carrier's y-axis back and forth in a line. An 
orbital shake moves both carrier axes to scribe a circle. With double orbital, the 
carrier scribes a figure-eight pattern. 

For any mode, a slider bar in the software allows you to adjust the shake frequency 
from "Slower" to "Faster." With each adjustment, the corresponding cycles per minute 
(CPM) is displayed. 

For either orbital mode, you can further expand the frequency options by clicking a 
Slow or Fast button. 
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Carrier Shake Definitions 

Shake Type Displacement  
(mm/steps) 

Period 
(msecs) 

Frequency 
(Hz) CPM Ramp 

Profile 

Linear 1/6 54.8 18.3 1096 13 

  2/12 82.0 12.2 731 14 

  3/18 105.8 9.5 567 15 

  4/24 121.6 8.2 493 16 

  5/30 146.3 6.8 410 17 

  6/36 166.9 6.0 360 18 

Slow 
orbital 1/6 107.3 9.3 559 19 

  2/12 164.4 6.1 365 20 

  3/18 212.5 4.7 282 21 

  4/24 253.5 3.9 237 22 

  5/30 292.1 3.4 205 23 

  6/36 334.2 3.0 180 24 

Fast orbital 1/6 74.3 13.4 807 25 

  2/12 109.6 9.1 548 26 

  3/18 141.3 7.1 425 27 

  4/24 169.0 5.9 355 28 

  5/30 195.4 5.1 307 29 

  6/36 222.8 4.5 269 30 

Maximum Shaking Amplitude Based on Assay Volume and 
Plate Type 

If the wells of a microplate are almost full, vigorous shaking can result in spillage 
inside the instrument. The following table is designed to help avoid this issue. Find 
your microplate type and sample volume to ascertain the acceptable shake amplitude 
on your instrument. 

Sample 
Volume Linear Orbital 

Slow 
Orbital 
Fast 

Double Orbital 
Slow 

Double Orbital 
Fast 

6-well Microplate 

0–3 mL 1–6 
mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm 

3–4 mL 1–6 
mm 1–6 mm 1–6 mm 1–6 mm 1 mm 
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Sample 
Volume Linear Orbital 

Slow 
Orbital 
Fast 

Double Orbital 
Slow 

Double Orbital 
Fast 

4–5 mL 1 mm 1–6 mm 1–6 mm 1–6 mm 1 mm 

5–7 mL 1 mm  1–6 mm 1–3 mm 1 mm No  

7–8 mL 1 mm No 1–3 mm No  No  

9 mL 1 mm  No No No No  

12-well Microplate 

0–1.5 mL 1–6 
mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm 

1.5–2.5 mL 1–2 
mm 1–6 mm 1–6 mm 1–6 mm 1 mm 

2.5–3 mL 1–2 
mm 1–6 mm No No 1 mm 

3–4 mL No 1–6 mm No No No 

24-well Microplate 

0–0.75 mL 1–6 
mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm 

0.75–1 mL 1 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm 

1–1.5 mL 1 mm 1–6 mm 1–6 mm 1–6 mm No 

1.5–2 mL 1 mm 1–6 mm No 1–6 mm No 

48-well Microplate 

0–0.5 mL 1–6 
mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm 

0.5–1 mL 1 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm 

1–1.3 mL No 1–6 mm 1–6 mm 1–6 mm No 

96-well Microplate 

0–0.25 mL 1–6 
mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm 

Gen5 Software 
BioTek Gen5 software supports all Cytation 5 reader models. Use Gen5 to control the 
reader, the imaging module (if equipped), the dispense module (if equipped), and 
the stacker (if equipped); perform data reduction and analysis on the measurement 
values; print or export results; and more. This section provides brief instructions for 
working with Gen5 to create protocols and experiments and read plates. Refer to the 
Gen5 Help system for more information and to learn about the various license levels 
available. 
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Define the Fluorescence Filter Cube 

For "F" models (filter fluorescence), the filter cube's characteristics must be entered 
into Gen5 and downloaded to the reader. Perform these steps before using the reader 
for the first time, and again if you change the filter cube's contents or switch to a 
different cube. 

1. Select System > Instrument Configuration. Highlight the Cytation 5, 
and click View/Modify. 

2. Click Setup, and then click the Filter Cube tab.  
3. Enter a name for the filter cube. 
4. Select Fluorescence Polarization Cube, if applicable. 
5. Enter a filter set name for Filter Set 1, and define the excitation, mirror, and 

emission settings: 
• Band Pass, a standard interference filter with a defined central wavelength 

and bandwidth. 
• Long Pass, cutoff filters that transmit longer wavelengths and block 

shorter wavelengths. 
• Short Pass, cutoff filters that transmit shorter wavelengths and block 

longer wavelengths. 
• Plug indicates the presence of a plug. 
• Hole indicates an empty location. 

6. Repeat step 5 for Filter Set 2. 

Protocols and Experiments 

In Gen5, a protocol contains instructions for controlling the reader and (optionally) 
instructions for analyzing the data retrieved from the reader. At a minimum, a 
protocol must specify the procedure for the assay you wish to run. After creating a 
protocol, create an experiment that references the protocol. You’ll run the experiment 
to read plates and analyze the data. 

These instructions briefly describe how to create a protocol in Gen5. See the Gen5 
Help system for complete instructions. 

1. Open a new protocol. 
2. Open the Procedure dialog. If prompted to select a reader, select the 

Cytation 5 and click OK. 
3. Select a Plate Type. 

Gen5 stores measurements and other characteristics for individual plate 
types in a database. It is essential that you select (or define) the plate 
type to match the assay plate. Otherwise, results may be invalid. 
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For imaging reads, you must also define the Bottom Elevation parameter 
for the plate or slide. If the relevant measurements are not defined, Gen5 
will not allow the objective to move closer than 1 mm from the bottom of 
the carrier, thus disabling Cytation 5’s focus capabilities. 

4. Add steps to the procedure for shaking or heating the plate, dispensing fluid, 
reading the plate, and more. Click Validate to verify that the reader 
supports the defined steps, and then click OK. 

Optionally, perform the next steps to analyze and report the results: 

5. Open the Plate Layout dialog and assign blanks, samples, controls, and/or 
standards to the plate. 

6. Open the Data Reduction dialog to add data reduction steps. Categories 
include Transformation, Well Analysis, Curve Analysis, Cutoff, and 
Validation. 

7. Create a report or export template via the Report/Export Builders. 
8. Select File > Save and give the file an identifying name.  

These instructions briefly describe how to create an experiment and then read a plate 
in Gen5. See the Gen5 Help system for complete instructions. 

1. Open a new experiment. 
2. Select the desired protocol and click OK. 
3. Select a plate in the menu tree and read it. 
4. When the read is complete, measurement values appear in Gen5. Select the 

desired data set from the Data list. 
5. Select File > Save and give the file an identifying name.  

Imaging Module: Manual Mode 

Applies only to models with the imaging module. 

The following sections briefly describe how to use the Gen5 imaging module in 
manual mode. See the Gen5 Help for more complete instructions and descriptions of 
these features. 

Focusing the Camera 

1. From the Task Manager, select Read Now > Run Imager Manual Mode. 

Alternatively, from the main Gen5 screen, click . 
2. Click Find Image. Gen5 automatically sets the exposure and focuses on the 

image. If the displayed image requires additional fine-tuning: 
• Click Auto Expose, or manually adjust the Exposure settings until you 

see an image. 
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• Click Auto Focus, or click the arrow buttons until the image is in focus.  
• Repeat these two steps until the image is exposed and focused to your 

liking. 

Capture and Save an Image 

When you have a satisfactory image, you can capture and save it for later analysis. 

1. When an image in the Capture dialog is in focus, click  to capture it. 
2. To save the captured images, click Review/Save. 

3. Click  to adjust the brightness and contrast adjustments or  to 
manually align overlaid images to compensate for pixel shift, then click 
Save. 

  

 

# Description 
1 Select a color channel 
2 Use the sliders or +/– buttons to adjust brightness and contrast 
3 Have Gen5 automatically adjust brightness and contrast 
4 Set to neutral settings (similar to the default settings) 
5 If selected, changes to brightness and contrast will apply to all color 

channels of the image 
6 Reset to default settings 
7 Select a color channel 
8 Gen5 displays the number of pixels the channel is shifted 
9 Reset to default settings 
10 Adjust the shift using the arrows 
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Adjustments made using the B&C (brightness and contrast) and Channel 
Shift dialogs are for display purposes only; the changes do not affect the 
data measurements from the images. 

Analyze Captured and Saved Images 

1. With your captured or saved images displayed in the left panel of the 
Capture dialog, click Review/Save. 

2.  If necessary, adjust the brightness and contrast of the image. 
3. Click Analyze. 
4. In the Analyze Tool, select which type of analysis you want to perform and 

define the parameters for the analysis, then click Start. The results are 
displayed in the right pane. 

Imaging Module: Experiment Mode 

Applies only to models with the imaging module. 

The following sections briefly describe how to use the Gen5 imaging module in 
experiment mode. See the Gen5 Help for more complete instructions and 
descriptions of these features. 

Perform an Image Read 

You can create an Image Read step to be used alone or in combination with the 
monochromator- or filter-based optics of the Cytation 5. 

1. Create a new protocol and select the Plate Type. 
2. Create a read step, and select Image as the Read Method. 
3. (Optional) Enter a step label or unique name for this step. Data sets of the 

reading results will use the label in online views, reports, and export files. 
4. Select the objective. 
5. Define whether to read a full plate or specific wells. 
6. Define up to four channels to read: 

a. Defining the color filter.  
b. Select whether exposure is automatic or defined. 
c. Define which wells are used for auto-exposure for each channel, if 

applicable. 
d. Define focus and exposure options, if needed. 

7. Define the horizontal and vertical offset from the center of the well. 
8. Select whether to create a single image for each well, an image montage, or 

an image Z-stack. 
9. Define advanced options, if needed.  
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After you have defined and saved the protocol, you can create an experiment and 
read the plate: 

1. Create an experiment using an existing protocol. 
2. Select the protocol you created with the imaging read step, and click OK. 
3. Select a plate in the menu tree and read it. 
4. When prompted, give the file an identifying name.  
5. When the read is complete, images and measurement values appear in Gen5. 

Select the desired data set from the Data list. 

Using the Slide Holder 

Manual Mode 

1. When prompted upon entering manual mode, select one of the slide holders 
as your plate type. 

2. The slide holder plate map contains two well positions that correspond with 
the two slide locations on the slide holder. Select the well position that 
contains the slide you want to image. 

3. By default, the carrier moves so that the middle of the selected slide position 
is below the objective. However, the sample on your slide may be in a 
different location on the slide. To find the sample: 

a. Select your lowest-power objective. 
b. Select either Small step or Large step, then use the arrow buttons to 

move the slide around until you find your sample. The cross in the slide 
display to the right of the arrow buttons shows the general position of the 
image in relation to the slide. The back arrow to the left of the slide display 
shows the direction that the slide enters the read chamber. 

 
4. After you find your sample, you can change to a higher-power objective, if 

desired, or define a Read step in a protocol using the x- and y-coordinates of 
your sample, which are displayed below the Well button. 

Experiment Mode 

1. In an experiment, select one of the slide holders as the plate type, and create 
an Image read step. 

2. Clear the Auto box to turn off Auto Exposure, then click  to enter 
manual mode. 

3. Follow steps 2 and 3 in the manual mode procedure (above) to find your 
samples, then click Save settings. Gen5 imports your exposure settings 
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and the values for Horizontal and Vertical offset from the center of the well 
to your read step. 

4. Select Auto to turn Auto Exposure back on. Gen5 will auto-expose your 
image, retaining the well offset imported from manual mode. 

You can also enter the values for Horizontal and Vertical offset from 
center of well if you had determined them during previous testing. 

Dispense Module Control 

This section applies only to models with injectors. 

Gen5 is used to perform several dispense functions, such as initialize, dispense, 
prime, and purge. The Prime and Purge functions are introduced here. See the Gen5 
Help system for more information. 

Priming and purging routines are used to clean the fluid paths. 

Prime 

Before running an experiment with a dispense step, prime the system with the fluid 
to be used. 

1. Place the priming plate on the carrier. 
2. Fill the supply bottle with a sufficient volume of the fluid to be used for the 

prime and the assay. Insert the appropriate inlet tube into the bottle. 
3. In Gen5, select System > Instrument Control > Cytation 5 and click 

the Prime tab. 
4. Select the Dispenser number (1 or 2) associated with the supply bottle. 
5. Enter the Volume to be used for the prime. The minimum recommended 

prime volume is 2000 µL. 
6. Select a prime Rate, in µL/second. 
7. Click Prime to start the process. 
8. When finished, carefully remove the priming plate from the carrier and 

empty it. 

If the priming plate is empty, the prime volume was too low. 

Purge 

To save reagent, Gen5 provides the option to purge fluid from the system back into 
the supply bottle. 
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1. In Gen5, select System > Instrument Control > Cytation 5 and click 
the Prime tab. 

2. Select the Dispenser number (1 or 2) associated with the supply bottle. 
3. Enter the desired purge Volume in µL (e.g., 2000). 
4. Select a prime Rate in µL/second. 
5. Click Purge to start the process.  
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Preventive Maintenance  
A general preventive maintenance regimen for all Cytation 5 models includes 
periodically cleaning all exposed surfaces and inspecting/cleaning the objectives, 
emission and excitation filters, and mirrors (if used). 

For models with the external dispense module, additional tasks include 
flushing/purging the fluid path and cleaning the tip prime trough, priming plate, 
supply bottles, dispense tubing, and injectors. 

Daily Cleaning for the Dispense Module 

To ensure accurate performance and a long life for the dispense module and 
injectors, flush and purge the fluid lines with deionized (DI) water every day or after 
completing an assay run, whichever is more frequent. Some reagents may crystallize 
or harden after use and clog the fluid passageways. Take special care when using 
molecules that are active at very low concentrations (e.g., enzymes, inhibitors). 
Remove any residual reagent in the dispense lines using a suitable cleaning solution 
(review the reagent’s package insert for specific recommendations). 

Flushing the tubing at the end of each day, letting the DI water soak overnight, and 
then purging the lines at the beginning of each day ensures optimal performance of 
the dispense system. BioTek recommends performing a visual inspection of the 
dispense accuracy before running an assay protocol that includes dispense steps. 

Models with injectors: Accumulated algae, fungi, or mold may require 
decontamination. See the Cytation 5 Operator’s Manual for complete 
decontamination instructions. 

Warnings and Precautions 
Read the following before performing any maintenance procedures: 

 

Warning! Internal Voltage. Turn off and unplug the instrument for all 
maintenance and repair operations. 

 

Important! Do not immerse the instrument, spray it with liquid, or use a 
“wet” cloth on it. Do not allow water or other cleaning solution to run into 
the interior of the instrument. If this happens, contact BioTek’s Technical 
Assistance Center. 

 

Important! Do not apply lubricants to the microplate carrier or carrier 
track. Lubricant attracts dust and other particles, which may obstruct the 
carrier path and cause errors. 

 

Warning! Wear protective gloves when handling contaminated 
instruments. Gloved hands should be considered contaminated at all times; 
keep gloved hands away from eyes, mouth, nose, and ears. 
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Warning! Mucous membranes are considered prime entry routes for 
infectious agents. Wear eye protection and a surgical mask when there is a 
possibility of aerosol contamination. Intact skin is generally considered an 
effective barrier against infectious organisms; however, small abrasions and 
cuts may not always be visible. Wear protective gloves when handling 
contaminated instruments. 

 

Caution! The buildup of deposits left by the evaporation of spilled fluids 
within the read chamber can impact measurements. Be sure to keep System 
Test records before and after maintenance so that changes can be noted. 

 
Warning! The instrument with all available modules weighs up to 80 lbs. 
(36.3 kg). Use two people when lifting and carrying the instrument. 

 

Clean Exposed Surfaces 
Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened (not 
soaked) with water or water and a mild detergent. You’ll need: 

• Deionized or distilled water 
• Clean, lint-free cotton cloths 
• Mild detergent (optional) 
• Canned air 

1. Turn off and unplug the instrument. 
2. Moisten a clean cotton cloth with water, or with water and mild detergent. 

Do not soak the cloth. 
3. Wipe the plate carrier and all exposed surfaces of the instrument. 
4. Instruments with imaging capability: Used canned air to blow debris from 

the aperture on the carrier. Do not wipe with liquid, which can seep inside 
aperture’s glass plates and impact imaging reads. 
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5. Wipe all exposed surfaces of the dispense module (if used). 
6. Wipe all exposed surfaces of the gas controller module (if used). 
7. If detergent was used, wipe all surfaces with a cloth moistened with water. 
8. Use a clean, dry cloth to dry all wet surfaces. 

Models with a dispenser: If the Tip Priming Trough overflows or other 
spills occur inside the instrument, wipe the carrier and the surface 
beneath the carrier with a dry cotton cloth. The internal chamber and 
probes are not customer-accessible. If overflow is significant, contact 
BioTek’s Technical Assistance Center with any questions about your 
particular model. 

Inspect/Clean Mirrors 
Applies only to Cytation 5 models with filter-based fluorescence capabilities. 

We recommend inspecting/cleaning the mirrors and polarizing filters (if equipped) 
annually, especially if the filter cube has been opened or changed. 

These optical elements are delicate and should be handled as carefully as possible. 
The glass and anti-reflective (AR) coated surfaces will be damaged by any contact, 
especially by abrasive particles. In most cases, it is best to leave minor debris on the 
surface. However, if performance indicators or obvious defects in the mirrors or 
filters suggest cleaning them, here are some guidelines: 

• Use of oil-free dry air or nitrogen under moderate pressure is the best method 
for removing excessive debris from an optical surface. If the contamination is 
not dislodged by the flow of gas, please follow the cleaning instructions below. 
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• The purpose of the cleaning solvent is only to dissolve any adhesive 
contamination that is holding debris on the surface. The towel needs to absorb 
both the excessive solvent and entrap the debris so that it can be removed from 
the surface. Surface coatings on dichroics are typically less hard than the 
substrate. It is reasonable to expect that any cleaning will degrade the surface at 
an atomic level. Consideration should be given as to whether the contamination 
in question is more significant to the application than the damage that may 
result from cleaning the surface. In many cases, the AR coatings that are 
provided to give maximum light transmission amplify the appearance of 
contamination on the surface. 

Materials 

• 7/64" hex key 
• Linen or cloth gloves 
• Anhydrous reagent-grade ethanol 
• Kimwipes 
• Magnifying glass 
• 100% pure cotton balls (for the polarizing filters) 

Procedure 

1. Open the access door on the front of the instrument and slide the filter cube 
straight out of its compartment. 

2. Set the filter cube on the work surface. Using a 7/64" hex key, remove the 
screw and washer located between the emission filter positions. 

 

3. Carefully lift the filter cube top from the cube. 
4. Wearing linen or cloth gloves, grasp the mirror by its edges and lift it out of 

the cube. 

The mirrors are seated on a shelf in the bottom of the cube and are not 
secured in place. 
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5. Wet absorbent towels such as Kimwipes, not lens paper, with anhydrous 
reagent-grade ethanol. Wear gloves or use enough toweling so that solvents 
do not dissolve oils from your hands that can seep through the toweling onto 
the coated surface. 

6. Drag the trailing edge of the ethanol-soaked Kimwipe across the surface of 
the mirror, moving in a single direction. A minimal amount of pressure can 
be applied while wiping. However, too much pressure will damage the 
mirror. 

7. Use the magnifying glass to inspect the surface; if debris is still visible, repeat 
with a new Kimwipe. 

8. To replace the mirror, hold it by its edges, turn it so that its label is face-up 
and readable, and place it on the shelf in the filter cube.  

 

9. Place the filter cube top back onto the cube and replace the screw and 
washer. 

10. When finished, reinstall the filter cube in the reader. 

Inspect/Clean Excitation and Emission Filters 
Applies only to Cytation 5 models with filter-based fluorescence capabilities. 

Laboratory air is used to cool the flash bulb, and the filter cubes can become dusty as 
a result. Filters should be inspected and cleaned at least every three months. You’ll 
need: 

• Isopropyl, ethyl, or methyl alcohol 
• 100% pure cotton balls or high-quality lens-cleaning tissue 
• Cloth gloves 
•  Magnifying glass 
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Do not touch the filters with your bare fingers! 

1. Open the access door on the front of the instrument. Slide the filter cube out 
of its compartment. 

2. Inspect the glass filters for speckled surfaces or a “halo” effect. This may 
indicate deterioration due to moisture exposure over a long period of time. 

If you have any concerns about the quality of the filters, contact your 
BioTek representative. 

3. Using cotton balls or lens-cleaning tissue moistened with a small amount of 
high-quality alcohol, clean each filter by lightly stroking its surface in one 
direction.  

4. Use a magnifying glass to inspect the surface; remove any loose threads left 
from the cotton ball. 

5. Replace the filter cube and close the door. 

Clean the Objectives 
Applies only to models with the imaging module. 

The objectives used in the Cytation 5 should be cleaned when necessary using 
optical-grade swabs or lens paper moistened with lens cleaning solution or deionized 
water. Do not rub the lens. 

Materials 

• Air puffer 
• Tweezers 
• Magnifying glass 
• Lens cleaning tissue  
• Optical-grade swabs 
• Cleaning solvent 

 

Recommended Cleaning Solvents Non-recommended Cleaning 
Solvents 

HyperClean (hexamethyldisoloxan and ethanol), 
available from Olympus Methyl ethyl ketone (MEK) 

Isopropyl alcohol, 70%/30% with deionized water Dimethyl ketone (acetone) 

Methyl alcohol, 70%/30% with deionized water   

Ethyl alcohol, 70%/30% with deionized water   
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1. From the Gen5 main screen, go to System > Instrument Configuration, 
select Cytation 5, click View/Modify > Setup.  

2. In the Objective Configuration area in the Imaging Configuration tab, click 
Access next to the desired objective to rotate the objective turret to the 
access position for that objective. 

3. Open the side door of the instrument. Grasp one of the objectives, unscrew it 
from the objective turret, and remove it from the instrument.  

4. Inspect the lens, using a magnifying glass if necessary, to determine if there 
is dirt or dust present. If so, use a blower or a small paintbrush to remove 
any dirt and dust. 

Any dirt or dust on the surface of the lens can cause extensive damage if 
dragged across the surface. 

5. Soak either an optical-grade swab or a piece of lens cleaning tissue wrapped 
around tweezers in lens cleaning solvent or deionized water. 

6. Hold the swab or tissue-wrapped tweezers still and rotate the objective's lens 
around it. 

7. Dry the lens immediately with a clean lens tissue. 
8. Replace the objective in the objective turret, and screw it in to secure it. 
9. Repeat these steps to clean the second objective, if necessary. 

10. In the Imaging Configuration tab on Reader Setup dialog (which you opened 
in step 1), click Auto Calibration to calibrate the objectives.  

When the calibration is finished, the instrument is ready to use. 

Tips 

• Do not allow the lens to air dry.  
• Always use an unused portion of the lens tissue when wiping the lens. 
• If smears are still present after performing these steps, repeat the procedure. 

Flush/Purge the Fluid Path 
Applies only to Cytation 5 models with a dispenser. 

At the end of each day that the dispense module is in use, flush the fluid path using 
the Gen5 priming utility. Leave the fluid to soak overnight or over a weekend, and 
then purge the fluid before using the instrument again. 
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This flushing and purging routine is also recommended before 
disconnecting the outlet tubes from the reader, and before 
decontamination to remove any assay residue prior to applying isopropyl 
alcohol or sodium hypochlorite. 

To flush the fluid path: 

1. Fill two supply bottles with deionized or distilled water. Insert the supply 
(inlet) tubes into the bottles. 

2. Place the priming plate on the carrier. 
3. From the Gen5 main screen, select System > Instrument Control > 

Cytation 5. 
4. Click the Prime tab and select Dispenser 1. 
5. Set the Volume to 5000 µL. Keep the default prime rate. 
6. Click Prime to start the process. When the process is complete, carefully 

remove the priming plate from the carrier and empty it. 
7. Repeat the process for Dispenser 2. 

Leave the water in the system overnight or until the instrument will be used again. 
Purge the fluid from the system (see below) and then prime with the dispense 
reagent before running an assay. 

To purge the fluid from the system: 

1. Place the inlet tubes in empty supply bottles or a beaker. 
2. Select System > Instrument Control > Cytation 5. 
3. Click the Prime tab and select Dispenser 1. 
4. Set the Volume to 2000 µL. 
5. Click Purge to start the process. 
6. When the purge is complete, repeat the process for Dispenser 2. 

After purging the system, you may wish to run a quick Dispense protocol 
to visually verify the dispense accuracy. 

Empty/Clean the Tip Priming Trough 
Applies only to Cytation 5 models with a dispenser. 

The tip priming trough is a removable cup located in the rear pocket of the 
microplate carrier, used for performing the Tip Prime. The trough holds about 1.5 mL 
of liquid and must be periodically emptied and cleaned by the user. Gen5 will 
instruct you to do this at the start of an experiment that requires dispensing. 

1. Extend the microplate carrier and carefully remove the tip priming trough 
from the carrier. 
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2. Wash the trough in hot, soapy water. Use a small brush to clean in the 
corners. 

3. Rinse the trough thoroughly and allow it to dry completely. 
4. Replace the trough in the microplate carrier. 

Clean the Priming Plate 
Applies only to Cytation 5 models with a dispenser. 

Clean the priming plate regularly to prevent bacteria growth and residue buildup. 
Wash the plate in hot, soapy water, using a small brush to clean in the corners. Rinse 
thoroughly and allow it to dry completely. 

Clean the Dispense Tubes and Injectors 
Applies only to Cytation 5 models with a dispenser. 

The Cytation 5’s dispense tubes and injectors require routine cleaning, at least 
quarterly and possibly more frequently depending on the type of fluids dispensed. 

Required Materials 

• Protective gloves 
• Safety glasses 
• Mild detergent 
• Clean, lint-free cotton cloths 
• Deionized or distilled water 
• Stylus (stored in a plastic cylinder affixed to the rear of the dispense module or 

reader) (PN 2872304) 

Remove the Dispense Tubes and Injector Holders 
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1. Open the door on the front of the reader. 
2. Grasp the injector tip holder by the tab and pull it up out of its socket. 
3. Using your fingers, remove the thumbscrews securing the light shield to the 

top of the reader and slide the shield up the outlets tubes. 
4. Slide the injector tip holder through the hole in the top of the reader. 
5. Turn each tube’s thumbscrew counterclockwise and gently pull each tube 

from its injector tip. 
6. On the dispense module, turn each outlet tube’s thumbscrew 

counterclockwise to disconnect it from the injector. 

Clean the Dispense Tubes and Injectors 

Some reagents can crystallize and clog the tubing and injectors. Daily flushing and 
purging can help to prevent this, but more rigorous cleaning may be necessary if 
reagent has dried in the tubing or injectors. 

To clean the dispense tubes, soak them in hot, soapy water to soften and dissolve any 
hardened particles. Flush each tube by holding it vertically under a stream of water. 

To clean the injectors: 

1. Gently insert the stylus into each injector tip to clear any blockages. (The 
stylus is stored in a plastic cylinder affixed to the rear of the dispense 
module.) 

2. Stream water through the pipe to be sure it is clean. If the water does not 
stream out, try soaking in hot, soapy water and then reinserting the stylus. 

Be careful not to damage the injector tips. A damaged tip might not 
dispense accurately.  
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System Test 
Each time the Cytation 5 is turned on, it automatically performs a series of tests on 
the reader’s motors, lamp(s), the PMT(s), and various subsystems. If all tests pass, the 
microplate carrier is ejected and the green LED on the carrier switch remains on. 

If any test results do not meet the internally coded Failure Mode Effects Analysis 
(FMEA) criteria established by BioTek, the reader beeps repeatedly and the red LED 
on the carrier switch flashes. If this occurs, press the carrier eject button to stop the 
beeping. If necessary, initiate another system test using Gen5 to try to retrieve an 
error code from the reader.  

1. Turn on the reader and launch Gen5. 
2. If your assays use incubation, we recommend enabling Temperature Control 

and allowing the incubator to reach its set point before running the system 
test. To access this feature, from the Gen5 main screen, select System > 
Instrument Control and click the Pre-Heating tab. 

3. Select System > Diagnostics > Run System Test. 
4. When the test is complete, a dialog appears, requesting additional 

information. Enter your user name and other information (if desired) and 
then click OK. 

5. The results report appears. It shows either “SYSTEM TEST PASS” or 
“SYSTEM TEST FAIL *** ERROR (error code) DETECTED.” 

6. Print the report if desired. 
7. If the test failed, look up the error code in the Cytation 5 Operator’s Manual to 

determine its cause. If the cause is something you can fix, turn off the reader, 
fix the problem, and then turn the reader back on and retry the test. If the test 
continues to fail, or if the cause is not something you can fix, contact BioTek’s 
Technical Assistance Center. 

Absorbance Plate Test 
This test uses BioTek’s Absorbance Test Plate (PN 7260522) to confirm mechanical 
alignment; optical density accuracy, linearity, and repeatability; and wavelength 
accuracy. The Absorbance Plate Test compares the reader’s optical density and 
wavelength measurements to NIST-traceable values. The Absorbance OD Standards 
section contains NIST-traceable standard OD values for the filters at several different 
wavelengths. We recommend testing at six wavelengths—those at or close to the 
wavelengths used in your assays. 

Setup 

1. Obtain the certificates that came with the Test Plate. 
2. Start Gen5 and from the main screen select System > Diagnostics > Test 

Plates > Add/Modify Plates. 
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3. Click Add. The Absorbance Test Plate dialog appears. 
4. Select the appropriate Plate Type and enter the plate’s serial number. 
5. Enter the Last Certification and Next Certification dates from the calibration 

sticker on the Test Plate. 
6. If the wavelength values in the top row of the grid in Gen5 are appropriate 

for your tests, enter the OD values from the data sheet into the grid. Make 
sure you enter the correct value for each well/wavelength combination. 

7. Select the number of Peak Wavelength tests to run (up to 4), based on the 
number of expected peak wavelength values provided on the certificate. 

8. Enter the Expected Peak value(s) from the certificate and set the Test Range – 
and + values.  
• If the C6 filter is Holmium or Erbium glass, the certificate contains two 

Spectral Band Pass tables. The Cytation 5 has a band pass wider than 5 
nm for wavelengths greater than 285 nm and less than 4 nm for 230–285 
nm. As a results, we recommend you use the expected peak values in 
the 5.0 nm table for your tests. 
 For the Erbium glass, any peak can be used. 
 For the Holmium glass, use the expected peak values closest to 242, 

279, 362, 417, and 538 nm. For example, if your certificate looks like 
the one below, you might choose to run the test at four of the five 
highlighted Expected Peak/Test Range combinations: 

 
2.4 nm Spectral Band Pass   5.0 nm Spectral Band Pass 

Expected Peak Test Range   Expected Peak Test Range 

241 -5+5   242 -5+5 

278 -6+4   279 -6+4 

287 -4+6   288 -4+6 

334 -5+5   334 -5+5 

360 -5+5   362 -5+5 

417 -5+5   417 -5+5 

484 -5+5   485 -5+5 

537 -5+5   538 -5+5 

642 -5+5   643 -5+5 
 

• If your C6 filter is Didymium glass, a single peak wavelength value is 
provided. Enter this value and set the Test Range – and + values so the 
range displayed in parentheses is 580 to 590, as shown here: 
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9. Review all the values you entered. Click OK to save the data. 

The information you just entered is available on Gen5 each time the Absorbance Plate 
Test is performed. It may need to be modified after the annual recertification of your 
test plate. 

Procedure 

1. From the Gen5 main screen, select System > Diagnostics > Test Plates 
> Run. If prompted, select the desired Test Plate and click OK. 

2. When the Absorbance Test Plate Options dialog appears, select Perform 
Peak Wavelength Test if it is not already selected. 

3. Highlight the wavelength(s) to be included in this test. 

Select only those wavelengths most appropriate for your use of the 
reader. 

4. (Optional) Enter any Comments. 
5. Click Start Test. 
6. Place the Test Plate in the microplate carrier so that well A1 is in the right-

rear corner of the carrier. 
7. Click OK to run the test. 
8. When the test is completed, the results report appears. Scroll through the 

report; every result should show “PASS”.  

Imaging Tests  
These procedures test the level position of the carrier and the reliability of the Auto 
Focus feature.  

Required Materials 

• Imaging qualification plate, PN 1222520 
• 10X or lower objective 
• DAPI 377/447 cube (PN 1225100) 
• Gen5 protocols described beginning on page 61 

• Cytation 5 <x>X_CarrierLevel.prt 
• Cytation 5 AF_Reliability_<x>X.prt 
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Carrier Level Test 

This test determines how level the carrier is in relation to the imaging system. This 
test may be run with any of the following objectives: Meiji 2.5X, Zeiss 2.5X, 4X, or 
10X. 

1. Place the imaging qualification plate on the carrier with well A1 facing up in 
the right-rear corner of the carrier. 

2. If you have not already done so, create the protocol described on page 61. 
3. Create a new experiment in Gen5 using the <x>X_CarrierLevel.prt protocol, 

with <x> representing the lowest-power objective you have available. 
4. Click Plate > Read Plate, save the experiment, then click OK. 
5. When prompted by Gen5, rotate the plate 180 degrees in the carrier. 
6. When the read is finished, analyze the results as described below. 

Analyze the Results 

1. Calculate the Mean focus height for each set of ten reads in the "Normal" 
position in wells A1, A12, H1, and H12. 

2. Calculate the Mean focus height for each set of ten reads in the "Turnaround" 
position in wells A1, A12, H1, and H12. 

3. Compare the Mean values for each well in its Normal and Turnaround 
positions by performing these calculations: 

a. –1 * (A1 Normal Mean – H12 Turnaround Mean) 
b. (H12 Normal Mean – A1 Turnaround Mean) 
c. –1 * (A12 Normal Mean – H1 Turnaround Mean) 
d. (H1 Normal Mean – A12 Turnaround Mean) 

4. For A1/H12: 
• Calculate the Mean Delta (µm): (step a results + step b result) / 2 
• Calculate the Carrier Tilt: Mean Delta / 25400 µm 
• The Carrier Tilt must be less than 0.004" to Pass. 

5. For A12/H1: 
• Calculate the Mean Delta (µm): (step c results + step d result) / 2 
• Calculate the Carrier Tilt: Mean Delta / 25400 µm 
• The Carrier Tilt must be less than 0.004" to Pass. 

AutoFocus Test 

The AutoFocus test confirms the imaging system's ability to repeatedly focus on a 
known target. 

1. Place the imaging qualification plate on the carrier with well A1 facing up in 
the right-rear corner of the carrier. 
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2. If you have not already done so, create the protocol described starting on 
page 61. 

3. Create a new experiment in Gen5 using the AF_Reliability_<x>.prt protocol, 
with <x> representing the objective you are using for each test. 

4. Click Plate > Read Plate, save the experiment, then click OK. 
5. When the read is finished, analyze the results as described below. 

Analyze the Results 

1. For the set of 100 data points in well F7, calculate the Mean, Slope, 
and Intercept. (If using Microsoft Excel, use the SLOPE and INTERCEPT 
functions.) 

2. For each data point, calculate the Residual:  
 
[value]–((Slope*[data point sequence #])+Intercept)  
 
Example: 325–((0*1)+325.9)=–0.9 Residual for data point #1 

3. For each data point, compare the absolute value of the Residual with the 
objective's Limit (µm) value in the chart below (e.g., 95.4 for 2.5X). If the 
absolute value of the Residual is greater than the Limit, note "1" for that data 
point; otherwise, note "0".  

Depth of Field 

Objective Magnification NA e (µm) λ (nm) DOF (µm) Limit (µm) 

10X 10 0.3 6.45 377 6.3 12.7 

4X 4 0.13 6.45 377 34.7 69.4 

Zeiss 2.5X 2.74 0.12 6.45 377 45.8 91.6 

Meiji 2.5X 2.25 0.07 6.45 377 117.9 235.8 

4. After conducting this comparison for all 100 data points, add up the 
notations and divide the sum by 100; this is the Measured Autofocus Failure 
Rate. The Measured Autofocus Failure Rate must be ≤ 1.0% to Pass. 

5. In the Gen5 plate matrix, select the FM Ratio [0:DAPI 377,447] data set. 
Refer to the chart below for passing criteria for the value displayed in well 
F7. 

Objective FM Ratio must be 

Meiji 2.5X > 1.4 

Zeiss 2.5X > 1.4 

4X > 25 

10X > 50 
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Troubleshooting 

If any of the imaging tests fail: 

• Ensure the imaging qualification plate is clean. You can use canned air to blow 
any debris from the surface of the plate. 

• Ensure your objectives are clean.  
• If your imaging tests still fail after cleaning the imaging qualification plate and 

the objectives, contact BioTek TAC. 

Imaging Protocols 

The information in the following tables represents the recommended reading 
parameters. It is possible that your tests will require modifications to some of these 
parameters, such as the Plate Type. 

The Plate Type setting in each Gen5 protocol should match the plate you 
are actually using. 

Carrier Level Tests 

Cytation 5 Meiji 2.5X_CarrierLevel.prt, Cytation 5 Zeiss 
2.5X_CarrierLevel.prt, Cytation 5 4X_CarrierLevel.prt, Cytation 5 
10X_CarrierLevel.prt 

Parameter Default Setting 

Detection Method: Imaging 

Read Type: Endpoint 

Plate Type: 1222520 (imaging qualification plate) 

Read Step 1 

Process Mode: Well Mode 

Kinetic Step: 
Run Time: 18:00 
Interval: 2 seconds 
Reads: 10 

Objective: Meiji 2.5X/Zeiss 2.5X/4X/10X 

Read Wells: A1, A12, H1, H12 

Color Channel: Bright Field 
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Parameter Default Setting 

Exposure: 
LED: 5 
Integration time: 50 
Gain: 0 

Auto Focus Options: 

Focus method: Auto focus with optional scan 
Minimum focus metric ratio: 3 
Scan distance: 600 
Scan increment: 30 
Minimum focus delta: 8 
% of capture exposure for focus: 75 
Offset from bottom of well: 0 

Vibration Detection Options: CV Threshold: 0.01 
Images to average: 1 

Horizontal offset from center of well: 0 

Vertical offset from center of well: 0 

Single image per well: Selected 

Delay after plate movement: 300 msec 

After Read Step 1 

Plate Out, In "Please rotate the plate 180 degrees" 

Read Step 2 

Process Mode: Well Mode 

Kinetic Step: 
Run Time: 18:00 
Interval: 2 seconds 
Reads: 10 

Objective: Meiji 2.5X/Zeiss 2.5X/4X/10X 

Read Wells: A1, A12, H1, H12 

Color Channel: Bright Field 

Exposure: 
LED: 5 
Integration time: 50 
Gain: 0 

Auto Focus Options: 

Focus method: Auto focus with optional scan 
Minimum focus metric ratio: 3 
Scan distance: 600 
Scan increment: 30 
Minimum focus delta: 8 
% of capture exposure for focus: 75 
Offset from bottom of well: 0 
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Parameter Default Setting 

Vibration Detection Options: CV Threshold: 0.01 
Images to average: 1 

Horizontal offset from center of well: 0 

Vertical offset from center of well: 0 

Single image per well: Selected 

Delay after plate movement: 300 msec 

AutoFocus Reliability Tests 

Cytation 5 AF_Reliability_Meiji 2.5X.prt, Cytation 5 AF_Reliability_Zeiss 
2.5X.prt 

Parameter Default Setting 

Detection Method: Imaging 

Read Type: Endpoint 

Plate Type: 1222520_AF (imaging qualification plate) 

Kinetic Step: Run Time: 19:59, Interval: 12 seconds, Reads: 
100 

Objective: Meiji 2.5X/Zeiss 2.5X 

Read Wells: F7 

Color Channel: DAPI 377, 447 

Exposure: Auto 

Auto-Focus Options: 

Focus method: Auto focus with optional scan 
Minimum focus metric ratio: 3 
Scan distance: 600 
Scan increment: 30 
Minimum focus delta: 8 
% of capture exposure for focus: 75 
Offset from bottom of well: -50 

Auto-Exposure Options: 
Target exposure %: 75 
Skip %: 0.1 
Integration threshold: 100 

Vibration Detection Options: CV Threshold: 0.01 
Images to average: 5 

Horizontal offset from center of 
well: 0 

Vertical offset from center of well: 0 
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Parameter Default Setting 

Single image per well Enabled 

Delay after plate movement: 0 msec 

Cytation 5 AF_Reliability_4X.prt  

Parameter Default Setting 

Detection Method: Imaging 

Read Type: Endpoint 

Plate Type: 1222520_AF (imaging qualification plate) 

Kinetic Step: Run Time: 19:59, Interval: 12 seconds, Reads: 
100 

Objective: 4X 

Read Wells: F7 

Color Channel: DAPI 377, 447 

Exposure: Auto 

Auto-Focus Options: 

Focus method: Auto focus with optional scan 
Minimum focus metric ratio: 25 
Scan distance: 600 
Scan increment: 30 
Minimum focus delta: 8 
% of capture exposure for focus: 75 
Offset from bottom of well: -50 

Auto-Exposure Options: 
Target exposure %: 75 
Skip %: 0.1 
Integration threshold: 100 

Vibration Detection Options: CV Threshold: 0.01 
Images to average: 5 

Horizontal offset from center of 
well: 0 

Vertical offset from center of well: 0 

Single image per well Enabled 

Delay after plate movement: 0 msec 

Cytation 5 AF_Reliability_10X.prt 

Parameter Default Setting 

Detection Method: Imaging 

Read Type: Endpoint 
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Parameter Default Setting 

Plate Type: 1222520_AF (imaging qualification plate) 

Kinetic Step: Run Time: 19:59, Interval: 12 seconds, Reads: 
100 

Objective: 10X 

Read Wells: F7 

Color Channel: DAPI 377, 447 

Exposure: Auto 

Auto-Focus Options: 

Focus method: Auto focus with optional scan 
Minimum focus metric ratio: 50 
Scan distance: 600 
Scan increment: 30 
Minimum focus delta: 8 
% of capture exposure for focus: 75 
Offset from bottom of well: -50 

Auto-Exposure Options: 
Target exposure %: 75 
Skip %: 0.1 
Integration threshold: 100 

Vibration Detection Options: CV Threshold: 0.01 
Images to average: 5 

Horizontal offset from center of 
well: 0 

Vertical offset from center of well: 0 

Single image per well Enabled 

Delay after plate movement: 0 msec 

Absorbance Liquid Test 
This test confirms the reader’s ability to perform to specification with liquid samples. 
If the test passes, then the lens placement and optical system cleanliness are proven. 

Materials 

• New 96-well, clear, flat-bottom microplate (Corning Costar #3590 
recommended) 

• Stock Solution A or B, which may be formulated by diluting a dye solution 
available from BioTek (A) or from the ingredients listed below (B). 

Solution A 

• BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; PN 7120782, 125 mL) 
• Deionized water 
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• 5-mL Class A volumetric pipette 
• 100-mL volumetric flask 

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a 100-mL 
volumetric flask. 

2. Add 95 mL of DI water; cap and shake well. The solution should measure 
approximately 2.000 OD when using 200 µL in a flat-bottom microwell. 

Solution B 

• Deionized water 
• FD&C Yellow No. 5 dye powder (typically 90% pure) 
• Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting agent 

(PN 7773002) (a 10% Tween solution) 
• Precision balance with capacity of 100 g minimum and readability of 0.001 g 
• Weigh boat 
• 1-liter volumetric flask 

1. Weigh out 0.092 g of FD&C Yellow No. 5 dye powder into a weigh boat. 
2. Rinse the contents into a 1-liter volumetric flask. 
3. Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent. 
4. Fill to 1 liter with DI water; cap and shake well. The solution should measure 

approximately 2.000 OD when using 200 µL in a flat-bottom microwell. 

Procedure 

1. Using freshly prepared stock solution (Solution A or B), prepare a 1:2 
dilution using deionized water (one part stock, one part deionized water; the 
resulting solution is a 1:2 dilution). 

2. Pipette 200 µL of the concentrated solution (A or B) into the first column of 
wells in the microplate. 

3. Pipette 200 µL of the diluted solution into the second column of wells. 

4. Using Gen5, read the plate five times at 405 nm using the Normal read mode, 
single wavelength, no blanking. Save the data after each read (“Normal plate 
position”). 

5. Without delay, rotate the plate 180 degrees so that well A1 is in the H12 
position. Read the plate five more times, saving the data after each read 
(“Turnaround plate position”). 

6. Print ten sets of raw data, or export them to an Excel spreadsheet. 

BioTek Instruments, Inc. 



Fluorescence Liquid Tests | 67 

Analyze the Results 

• The plate is read five times in “Normal” position at 405 nm. Calculate the 
Mean OD and Standard Deviation of those five reads for each well in 
columns 1 and 2. 

• For each well in columns 1 and 2, calculate the Allowed Deviation using the 
repeatability specification for a 96-well plate: ± 1% ± 0.005 OD from 0.000 to 
2.000 OD (Mean * 0.010 + 0.005). For each well, its standard deviation should 
be less than its allowed deviation. 

• The plate is read five times in the “Turnaround” position at 405 nm. 
Calculate the Mean OD of those reads for each well in columns 11 and 12. 

• Perform a mathematical comparison of the Mean values for each microwell in 
its Normal and Turnaround positions (that is, compare A1 to H12, A2 to H11, 
B1 to G12,… H2 to A11). To pass the test, the differences in the compared 
mean values must be within the accuracy specification for a 96-well 
microplate: ± 1.0% ± 0.010 OD from 0.000 to 2.000 OD. 

Repeatability Specification 

± 1% ±0.005 OD from 0.000 to 2.000 OD 

±3.0% ±0.010 OD from 2.000 OD to 2.500 OD 

Fluorescence Liquid Tests  

Required Materials 

All Tests: 

• Deionized or distilled water 
• Various beakers, graduated cylinders, and pipettes 
• 95% ethanol (for cleaning clear-bottom plates) 
• Aluminum foil 
• (Optional, but recommended) 0.45-micron filter 
• (Optional) Black polyethylene bag(s) to temporarily store plate(s) 
• Gen5 protocols listed below and described on page 77 

For the Filter-Based Fluorescence System 

Cytation 5_FI_T_SF.prt Corners, Sensitivity, and Linearity tests, using the top 
optics 

Cytation 5_FP.prt Fluorescence Polarization test 

Cytation 5_TRF.prt Time-Resolved Fluorescence test 
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For the Monochromator-Based Fluorescence System 

Cytation 
5_M_FI_T_SF.prt 

Corners, Sensitivity, and Linearity tests, using the Top 
optics 

Cytation 
5_M_FI_B_SF.prt 

Corners, Sensitivity, and Linearity tests, using the Bottom 
optics 

Filter Set Setup 

Before using the filter-based fluorescence test protocols, create the applicable filter 
sets shown below in Gen5 ("Green" is used for sodium fluorescein tests, "Blue" for 
MUB).  

  

  

Corners/Sensitivity/Linearity Tests 

• Buffer: 
 NIST-traceable Sodium Borate Reference Standard (pH 9.18) (e.g., Fisher-

Scientific 1 L Sodium Borate Mfr. #159532, or equivalent), or 
 Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfr. 

#P4417, or equivalent) and pH meter or pH indicator strips with pH range 4 
to 10 

• Sodium Fluorescein Powder (1-mg vial, BioTek PN 98155) 

BioTek Instruments, Inc. 



Fluorescence Liquid Tests | 69 

• If testing both Top and Bottom optics (mono-based fluorescence only): A 
new, clean 96-well glass-bottom Greiner SensoPlate (Mfr. #655892); or a clean 
Hellma Quartz 96-well titration plate (Mfr. #730.009.QG); or equivalent 

• If testing the Top optics only: A new, clean 96-well solid black microplate, such 
as Corning Costar #3915, or equivalent 

• Excitation filter 485/20 nm installed 
• Emission filter 528/20 nm installed 
• 510-nm dichroic mirror installed 

Fluorescence Polarization (FP) Test 

• A new, clean, 96-well solid black microplate, such as Corning Costar #3915. A 
Greiner SensoPlate can also be used. 

The FP Test can be performed in conjunction with the top 
Corners/Sensitivity/Linearity Tests, in the same microplate. 

• The recommended test solutions are available from Invitrogen Corporation in 
their “FP One-Step Reference Kit” (PN P3088) or from BioTek (PN 7160014). 
This kit includes: 
 (Green) Polarization Reference Buffer, 15 mL 
 Green Low Polarization Reference, 4 mL 
 Green High Polarization Reference, 4 mL 

The kit also includes two red polarization solutions; these are not used. 

• Excitation filter 485/20 nm installed 
• Emission filter 528/20 nm installed 
• 510-nm dichroic mirror and polarizers installed 

Time-Resolved Fluorescence (TRF) Test 

• 15-mL conical-bottom, polypropylene sample tube 
• Excitation filter 360/40 nm installed 
• Emission filter 620/40 nm installed 
• 400-nm dichroic mirror installed 
• A new, clean 96-well solid white microplate, such as Corning Costar #3912 
• The recommended test solution (FluoSpheres carboxylate-modified 

microspheres, 0.2 µm europium luminescent, 2 μL) is available from Invitrogen 
Corporation (PN F20881) or from BioTek (PN 7160011) 
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Test Solutions 

Corners/Sensitivity/Linearity Tests 

 

If using BioTek’s sodium fluorescein powder (PN 98155), be sure to hold the 
vial upright and open it carefully; the material may be concentrated at the top. 
If a centrifuge is available, spin down the tube before opening.  

When diluting the sodium fluorescein powder in buffer, it takes time for the 
powder to completely dissolve. Allow the solution to dissolve for five minutes, 
with intermittent vortexing, before preparing the titration dyes.  

Wrap the vial containing the stock solution in foil to prevent exposure to light. 
Discard unused solution after seven days. Discard any open, unused buffer 
solution after seven days.  

1. The Sodium Borate solution does not require further preparation; proceed to 
step 2. If you are using PBS, prepare the solution: 
• (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of 

deionized or distilled water. 
• Follow the manufacturer’s instructions on the PBS packaging to create 200 

mL, dissolving the necessary amount of PBS into the filtered water. 
• Stir the solution (preferably using a stir table) until the PBS is completely 

dissolved. 
• Check the pH; it should be between 7.2 and 7.6 at 25°C. 

2. Prepare the sodium fluorescein stock solution: 
• Add 2.0 mL of the buffer solution to the 1 mg Sodium Fluorescein (SF) 

vial. This yields a 1.3288 mM stock solution. 
• Ensure that the dye has completely dissolved and is well mixed. 

3. Carefully prepare the dilutions. Label each with “SF” and the concentration: 

Mix This SF Solution: With 
Buffer: 

To 
Make:   

0.53 mL of 1.3288 mM stock 
solution 13.47 mL 50.2 μM   

110 µL of 50.2 μM SF 13.89 mL 400 nM   

3.5 mL of 400 nM SF 10.5 mL 100 nM   

0.46 mL of 100 nM SF 13.54 mL 3.3 nM Corners Test 

 4.24 mL of 3.3 nM SF 9.76 mL  1 nM Sensitivity/Linearity 
Tests 
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Fluorescence Polarization (FP) Test 

The recommended test solutions are available from Invitrogen Corporation or from 
BioTek. They do not require additional preparation. 

Time-Resolved Fluorescence (TRF) Test 

The recommended test solutions are available from Invitrogen Corporation or from 
BioTek. 

• Shake the FluoSpheres container vigorously for 30 seconds prior to pipetting. 
Alternatively, sonicate or vortex the container. 

• Mix 10 µL of FluoSpheres with 10 mL of deionized water, in a 15 mL conical-
bottom, polypropylene sample tube. This yields a 20 nM equivalent suspension. 

• Shake the vial vigorously for 30 seconds prior to pipetting. Alternatively, 
sonicate or vortex the container. 

• Mix 10 µL of 20 nM suspension with 10 mL of deionized water, in a 15 mL 
conical-bottom, polypropylene sample tube. This yields a 20 pM equivalent 
suspension. 

• Refrigerate any unused portions of the FluoSpheres. The temperature must be 
between +2°C to +6°C. 

The prepared TRF plate can be kept for a maximum of seven days, if 
covered and stored in the dark between +2°C to +6°C. 

Allow the plate to sit at room temperature for approximately 15 minutes 
prior to use. 

Procedure 

1. If you have not already done so, create the Gen5 protocols described starting 
on page 77. 

2. If you have not already done so, prepare the solutions for the tests you plan 
to perform. See Fluorescence Test Solutions on page 70. 

Refer to the pipette maps, next, for the remaining steps. 

3. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the 
filter-based fluorescence system: 
• Pipette the test solutions into a clean 96-well microplate. 
• Create an experiment based on the Cytation 5_FI_T_SF.prt protocol. Read 

the plate, and then save the experiment. 
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4. To test Fluorescence Polarization capability: 
• Pipette the solutions for the “FP” test into the same plate as used in step 3. 
• Create an experiment based on the Cytation 5_FP.prt protocol. Read the 

plate, and then save the experiment. 

5. Perform the Corners/Sensitivity/Linearity tests for the monochromator-
based fluorescence system: 
• Create experiments based on the Cytation 5_M_FI_T_SF.prt (for the top 

optics) and Cytation 5_M_FI_B_SF.prt (for the bottom optics) 

•  Read the plate and then save the experiment. 

6. To test the Time-Resolved Fluorescence capability: 
• Pipette the solutions for the “TRF” test into a new 96-well solid white 

plate. 
• Create an experiment based on the Cytation 5_TRF.prt protocol. Read the 

plate and then save the experiment. 

Pipette Maps 

Seal the plates with foil or store them in black polyethylene bags until 
use. When using a clear-bottom plate, if the base of the plate is touched, 
clean the entire base with alcohol (95% ethanol) and then wipe with a 
lint-free cloth. Before placing the plate in the instrument, blow the 
bottom of the plate with an aerosol duster. 

Perform these steps carefully, and refer to the grid on the next page. 

For the Corners test (light gray wells): 

• Pipette 200 μL of the 3.3 nM SF solution into wells A1–A3, A10–A12, H1–H3, 
and H10–H12. 

• If using a Hellma plate: Pipette 200 μL of buffer into the wells surrounding the 3.3 
nM wells ("CBUF" in the grid). 

For the Sensitivity test (dark gray wells): 

• Pipette 200 μL of the 1 nM SF solution into well D7. 
• Pipette 200 μL of the buffer solution into wells C9, D9, and E9. 

For the Linearity test (wells C1–F5): 

• Use a multichannel pipette with just four tips installed. 
• Pipette 150 μL of buffer solution into wells C2–F5. Discard the tips. 
• Pipette 150 μL of the 1 nM SF solution into wells C1–F1. 
• Pipette 150 μL of the 1 nM SF solution into wells C2–F2. Mix the wells using the 

pipette. Do not discard the tips. 
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• Aspirate 150 μL from wells C2–F2, and dispense into wells C3–F3. Mix the wells 
using the pipette. Do not discard the tips. 

• Aspirate 150 μL from wells C3–F3, and dispense into wells C4–F4. Mix the wells 
using the pipette. Do not discard the tips. 

• Aspirate 150 μL from wells C4–F4, and dispense into wells C5–F5. Mix the wells 
using the pipette. Do not discard the tips. 

• Aspirate 150 μL from wells C5–F5, and discard the tips. 

 

Fluorescence Polarization (FP) Test 

• Pipette 200 µL of the (green) polarization buffer (BUF) into wells A6–H6. 
• Pipette 200 µL of the green high polarization reference (HPR) into wells A7–B7. 
• Pipette 200 µL of the green low polarization reference (LPR) into wells A8–H8. 

  1 2 3 4 5 6 7 8 9 10 11 12 

A           BUF HPR LPR         

B           BUF HPR LPR         

C           BUF   LPR         

D           BUF   LPR         

E           BUF   LPR         

F           BUF   LPR         

G           BUF   LPR         

H           BUF   LPR         
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Time-Resolved Fluorescence (TRF) Test 

• Pipette 200 µL of deionized water into wells A6–C6. 
• If you have not already done so, shake the vial of 20 pM europium suspension 

vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or vortex 
the vial. 

• Pipette 200 µL of the 20 pM europium suspension (Eu) into well A8. 

  1 2 3 4 5 6 7 8 9 10 11 12 

A           DI   Eu         

B           DI             

C           DI             

D                         

E                         

F                         

G                         

H                         

Results Analysis 

Corners Test 

1. Calculate the Mean of the 12 wells containing the 3.3 nM SF test solution 
(A1–A3, A10–A12, H1–H3, and H10–H12). 

2. Calculate the Standard Deviation for the same 12 wells. 
3. Calculate the %CV: (Standard Deviation / Mean) * 100 

The %CV must be < 3.0 to pass. 

Sensitivity Test 

1. Calculate the Mean and Standard Deviation of the 16 reads for each of the 
buffer wells (C9, D9, E9). 

2. Among the three buffer wells, find the Median Standard Deviation and 
corresponding Mean. 

3. Calculate the Mean for the 16 reads of the SF Concentration well (D7). 
4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean SF Concentration, 

Buffer Median STD with its corresponding Buffer Mean: 
(SF Mean – Buffer Mean)/(3 * Buffer STD) 

5. Calculate the Detection Limit, in pM, using the known concentration value of 
SF and the Calculated SNR: 1000/SNR 
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Filter-Based Fluorescence System 

Optic Probe To pass, the Detection Limit  
must be less than or equal to: 

Top  10 pM 

 
Monochromator-Based Fluorescence System 

Optic Probe To pass, the Detection Limit  
must be less than or equal to: 

EX 485 nm,  
EM 528 nm Top/Bottom: 20 pM  

Linearity Test 

1. Calculate the Mean of the four wells for each concentration in columns 1–5. 
2. Perform linear regression using these values as inputs: 

Filter- and Monochromator-Based  
Fluorescence System 

x y 

1000 Mean of the 1000 pM wells 

500 Mean of the 500 pM wells 

250 Mean of the 250 pM wells 

125 Mean of the 125 pM wells 

62.5 Mean of the 62.5 pM wells 

3. Calculate the R-Square value; it must be >= 0.950 to pass. 

Fluorescence Polarization (FP) Test 

1. Using the raw data from the Parallel read: 
• Calculate the Mean Blank (wells A6–H6). 
• Calculate the Signal for each HPR well: Subtract the Mean Blank from its 

measurement value. 
• Calculate the Signal for each LPR well: Subtract the Mean Blank from its 

measurement value. 
2. Using the raw data from the Perpendicular read: 

• Calculate the Mean Blank (wells A6–H6) 
• Calculate the Signal for each HPR well: Subtract the Mean Blank from its 

measurement value. 
• Calculate the Signal for each LPR well: Subtract the Mean Blank from its 

measurement value. 
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3. Calculate the G-Factor for each LPR well: 
(Parallel LPR Sign * (1–0.02)) / (Perpendicular LPR Signal * (1+0.02)) 

4. Calculate the Mean G-Factor. 
5. Calculate the Polarization value in mP for each HPR well (“PLPR”): 

Parallel HPR Signal – Mean G-Factor * Perpendicular HPR Signal * 1000 
Parallel HPR Signal + Mean G-Factor * Perpendicular HPR Signal 

6. Calculate the Mean PHPR, in mP. 

 

Optic Probe To pass, the Mean PHPR  
must be greater than: 

Top, with 510 nm dichroic mirror 340 mP 
 

7. Calculate the Polarization value in mP for each LPR well (“PLPR”): 
Parallel LPR Signal – Mean G-Factor * Perpendicular LPR Signal * 1000 
Parallel LPR Signal + Mean G-Factor * Perpendicular LPR Signal 

8. Calculate the Standard Deviation of the “PLPR,” in mP. 

Optic Probe To pass, the Standard Deviation  
of the PLPR must be less than: 

Top, with 510 nm dichroic mirror 5 mP 

Time-Resolved Fluorescence (TRF) Test 

1. Calculate the Mean and Standard Deviation of the 16 reads for each of the 
buffer wells (A6, B6, C6). 

2. Among the three buffer wells, find the Median Standard Deviation and 
corresponding Mean. 

3. Calculate the Mean for the 16 reads of the Eu Concentration well (A8). 
4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean Eu Concentration 

and Buffer Median STD with its corresponding Buffer Mean: 
(Eu Mean – Buffer Mean)/(3 * Buffer STD) 

5. Calculate the Detection Limit, in fM: 
20000 / ((Mean Eu – Mean DI water) / (3 * Standard Deviation DI water) 

Optic Probe To pass, the Detection Limit  
must be less than or equal to: 

Top, with 400 nm dichroic mirror 250 fM 

Troubleshooting  

If any tests fail, please try the following suggestions. If the test(s) continue to fail, 
print the results and contact BioTek’s Technical Assistance Center. 
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• Are the solutions fresh? Discard the plate and any open, unused test solutions 
after seven days. 

• Are the excitation/emission filters clean? Are they in the proper locations and 
in the proper orientation in the filter cube? 

• If the Corners Test continues to fail, the hardware may be misaligned. Contact 
BioTek TAC. 

• Are you using new/clean plates? If the base of a clear-bottom plate is touched, 
clean the entire base with alcohol (95% ethanol) and then wipe with a lint-free 
cloth. Before placing the plate in the instrument, blow the bottom of the plate 
with an aerosol duster. If the test fails again, the optical probe(s) may need to be 
cleaned. Contact BioTek’s Technical Assistance Center for instructions. 

• Review the pipetting instructions to verify the plate was correctly prepared. 
• Does the Plate Type setting in the Gen5 protocol match the plate you used? 
• For injector models, spilled fluid inside the reader may be fluorescing, which 

can corrupt your test results. If you suspect this is a problem, contact BioTek 
TAC. 

• When testing Fluorescence Polarization capability using a solid black plastic 
microplate, if the standard deviation for the buffer wells is too high, try moving 
the buffer wells to another column. With some black plastic plates, the wells in 
the center of the plate may be slightly distorted due to the plate molding 
process, and this can affect the standard deviation. 

• The Read steps in the protocols use the Gen5 Automatic Gain Adjustment 
feature to determine optimum sensitivity values for the plate. If an Auto Gain 
Result value is outside the range of 50–200, this may indicate a problem. 
If the value is less than 50: 
 The stock solution/dilution concentrations may be too high. Try creating 

fresh solutions/dilutions, and rerun the test using a new, clean plate. 
 If all of the tests are passing but the Gain value is low, a PMT in your reader 

may just be very sensitive. Contact BioTek’s Technical Assistance Center to 
confirm that this may be the case. 

If the value is greater than 200: 
 The stock solution/dilution concentrations may be too low. Try creating 

fresh solutions/dilutions, and rerun the test using a new, clean plate. 
 For injector models, spilled fluid inside the reader may be fluorescing, which 

can corrupt your test results. If you suspect this is a problem, contact BioTek 
TAC. 

 The PMTs or optical path(s) may be deteriorating, or the optics or other 
hardware may be misaligned. Contact BioTek’s Technical Assistance Center. 

Gen5 Protocol Reading Parameters 

The information in the following tables represents the recommended reading 
parameters. It is possible that your tests will require modifications to some of these 
parameters, such as the Plate Type (see Troubleshooting Tips on page 76). 
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The Plate Type setting in each Gen5 protocol should match the plate you 
are actually using. 

Cytation 5_FI_T_SF.prt 

This procedure contains two Read steps using filters to test the top 
optics: one for the Corners Test and one for the Sensitivity/Linearity Test. 

Parameter Default Setting 

Plate Type: Costar 96 black opaque (#3915) 

Read Step 1 

Detection Method: Fluorescence 

Read Type: Endpoint 

Kinetic Loop 
Run Time: 00:00:45 
Interval: 00:00:03 
Reads: 16 

Step Label: "Sensitivity Read" 

Read Well: D7 

Filter Set: 1 (Green) 

Filters: EX 485/20 nm, EM 528/20 nm 

Optics Position: Top 510 nm 

Gain: Auto, Scale to High Wells, D7, 30000 

Read Speed: 

Normal 
Delay after plate movement: 350 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height: 7.00 mm 

Read Step 2 

Detection Method: Fluorescence 

Read Type: Endpoint 

Kinetic Loop 
Run Time: 00:01:35 
Interval: 00:00:06 
Reads: 16 

Step Label: "Sensitivity Read Buffer" 

Read Wells: C9..E9 

Filter Set: 1 (Green) 
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Parameter Default Setting 

Filters: EX 485/20 nm, EM 528/20 nm 

Optics Position: Top 510 nm 

Gain: Auto, Use first filter set gain from FIRST Read Step 

Read Speed: 

Normal 
Delay after plate movement: 350 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height: 7.00 mm 

Read Step 3 

Detection Method: Fluorescence 

Read Type: Endpoint 

Step Label: "Corners Read" 

Read Wells: A1..A3, A10..A12, H1..H3, H10..H12 

Filter Set: 1 (Green) 

Filters: EX 485/20 nm, EM 528/20 nm 

Optics Position: Top 510 nm 

Gain: Auto, Scale to High Wells, A3, 30000 

Read Speed: 

Normal 
Delay after plate movement: 350 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height: 7.00 mm 

Read Step 4 

Detection Method: Fluorescence 

Read Type: Endpoint 

Step Label: "Linearity Read" 

Read Wells: C1..F5 

Filter Set: 1 (Green) 

Filters: EX 485/20 nm, EM 528/20 nm 

Optics Position: Top 510 nm 

Gain: Auto, Scale to High Wells, C1, 30000 
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Parameter Default Setting 

Read Speed: 

Normal 
Delay after plate movement: 350 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height: 7.00 mm 

Cytation 5_FP.prt 

This procedure contains one Read step using filters with Fluorescence 
Polarization enabled, inside a Plate Mode block. 

Parameter Default Setting 

Detection Method: Fluorescence polarization 

Read Type: Endpoint 

Plate Type: Costar 96 black opaque (#3915) 

Shake Step: Linear for 15 seconds 

Delay Step: 5 seconds after shake 

Synchronized Mode: Plate Mode with Timing Control 

Read Wells: A6–H8 

Filter Sets: 1 (filter cube) 

Filters: EX 485/20 nm, EM 528/20 nm 

Optics Position: Top 510 nm 

Gain: Auto, Scale to high Wells, A8, 10000 

Read Speed: 

Normal 
Delay after plate movement: 350 msec 
Measurements per data point: 60 
Lamp Energy: Low 

Read Height: 7.0 mm 

Cytation 5_TRF.prt 

Parameter Default Setting 

Plate Type: Costar 96-well white opaque 

Delay Step: 3 minutes 

Read Step 1 

Detection Method: Time-resolved fluorescence 
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Parameter Default Setting 

Read Type: Endpoint 

Kinetic Loop 
Run Time: 00:00:15 
Interval: 00:00:01 
Reads: 16 

Step Label: "Sensitivity Read" 

Read Well: A8 

Filter Sets: 1 (filter cube) 

Filters: EX 360/40 nm, 620/40 nm 

Optics Position: Top 400 nm 

Gain: Auto, Scale to High Wells, A8, 30000 

Read Speed: 

Normal 
Delay after plate movement: 100 msec 
Measurements per data point: 50 
Lamp Energy: Low 

Read Height: 7.00 mm 

Read Step 2 

Detection Method: Time-resolved fluorescence 

Read Type: Endpoint 

Kinetic Loop 
Run Time: 00:00:45 
Interval: 00:00:03 
Reads: 16 

Step Label: "Sensitivity Read Buffer" 

Read Well: A6–C6 

Filter Sets: 1 (filter cube) 

Filters: EX 360/40 nm, 620/40 nm 

Optics Position: Top 400 nm 

Gain: Auto, Use first filter set gain from FIRST Read Step 

Read Speed: 

Normal 
Delay after plate movement: 100 msec 
Measurements per data point: 50 
Lamp Energy: Low 

Read Height: 7.00 mm 
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Cytation 5_M_FI_T_SF.prt and Cytation 5_M_FI_B_SF.prt 

Parameter Default Setting 

Plate Type: Top: Costar 96 black opaque 
Bottom: Greiner SensoPlate 

Read Step 1 

Detection Method: Fluorescence 

Read Type: Endpoint 

Kinetic Loop 
Run Time: 00:00:45 
Interval: 00:00:3 
Reads: 16 

Step Label:  "Sensitivity Read" 

Read Well: D7 

Wavelength: 1, EX 485/14, EM 528/14 nm 

Optics Position: Top/Bottom 

Gain Auto, Scale to High Wells, D7, 30000 

Read Speed: 

Normal 
Delay after plate movement: 100 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height (for top optics): 7.00 mm 

Read Step 2   

Detection Method: Fluorescence 

Read Type: Endpoint 

Kinetic Loop 
Run Time: 00:01:35 
Interval: 00:00:6 
Reads: 16 

Step Label:  "Sensitivity Read Buffer" 

Read Well: C9..E9 

Wavelength: 1, EX 485/14, EM 528/14 nm 

Optics Position: Top/Bottom 

Gain Auto, Use first filter set gain from FIRST Read Step 
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Parameter Default Setting 

Read Speed: 

Normal 
Delay after plate movement: 100 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height (for top optics): 7.00 mm 

Read Step 3   

Detection Method: Fluorescence 

Read Type: Endpoint 

Step Label:  "Corners Read" 

Read Wells: A1..A3, A10..A12, H1..H3, H10..H12 

Wavelength: 1, EX 485/14, EM 528/14 nm 

Optics Position: Top/Bottom 

Gain Auto, Scale to High Wells, A3, 30000 

Read Speed: 

Normal 
Delay after plate movement: 100 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height (for top optics): 7.00 mm 

Read Step 4   

Detection Method: Fluorescence 

Read Type: Endpoint 

Step Label:  "Linearity Read" 

Read Wells: C1..F5 

Wavelength: 1, EX 485/14, EM 528/14 nm 

Optics Position: Top/Bottom 

Gain Auto, Scale to High Wells, C1, 30000 
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Parameter Default Setting 

Read Speed: 

Normal 
Delay after plate movement: 100 msec 
Measurements per data point: 50 
Lamp Energy: Low 
Dynamic Range: Standard 

Read Height (for top optics): 7.00 mm 

Luminescence Test 
BioTek provides two methods for verifying the performance of luminescence reads. 
One method measures a Harta Luminometer Reference Microplate, which is an LED-
based test plate. Contact BioTek to purchase a plate, or go to 
www.hartainstruments.com for more information. The other method measures a 
LUX Biotechnology, Ltd., Glowell unit, which is a small, sealed cylinder with a 
gaseous tritium light source. 

Before using the Cytation 5 F-LumTest_Harta.prt or Cytation 5 F-
LumTest_Glowell.prt protocols described in this section, create the filter set shown 
below. 

 

Harta Plate Test 

Materials 

• Harta Luminometer Reference Microplate, PN 8030015 
• Harta Plate Adapter, PN 1222205 
• Filter cube PN 8040553, LUM Filter Block or a filter cube with a plug in 

EX position 1 or 2 and a hole in the corresponding EM position 
• Gen5 protocol described started on page 88 
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Procedure 

1. Turn on the Harta reference plate using the I/O switch on the back of the 
plate. 

2. Check the plate’s battery by pressing the test button on the back of the plate 
and ensuring that the test light turns on. 

The test light may be difficult to see in bright light. Change your angle of 
view or move to a darker environment if you cannot see it. 

3. Place the Harta plate adapter on the reader’s carrier, then place the test plate 
on top of the adapter. 

4. Create an experiment based on the Cytation 5 F-LumTest_Harta.prt or  
Cytation 5 M-LumTest_Harta.prt protocol and read the plate. 

5. Calculate and evaluate the results as described on page 86. 

Be sure to turn off the Harta plate when you are finished with the test to 
preserve battery life. 

Plate Layout 

Cytation 5 F-LumTest_Harta.prt 

  1 2 3 4 5 6 7 8 9 10 11 12 

A   A2 
meas         battery  

check 
battery  
check         

B                         

C                         

D BUF BUF BUF BUF                 

E BUF BUF BUF BUF                 

F BUF BUF BUF BUF                 

G BUF BUF BUF BUF                 

H                        
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Cytation 5 M-LumTest_Harta.prt 

  1 2 3 4 5 6 7 8 9 10 11 12 

A   A2 
meas         battery  

check 
battery  
check         

B                         

C                         

D                         

E                         

F BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF 

G BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF 

H                        

Harta Plate Results Analysis 

Through a manual correlation process, it was found that the system 
requires approximately 35 photons per attomole of ATP, thus a 
conversion factor of 0.02884 attomole/photon was applied to determine 
ATP concentration from the NIST data in photons/s. 

1. On the Harta plate’s Calibration Certificate, locate the NIST measurement for 
the A2 position and convert it to attomoles:  
(A2 NIST measurement * 0.02884) 

2. Determine if the plate’s battery is still functioning properly: 
 If A8 > (0.2 * A7), the battery is good. Otherwise, it requires replacement. 

A replacement battery is included with each Harta plate. A new 
spare battery will be supplied when the plate is recertified.  

3. Calculate the signal-to-noise ratio: 
(A2 – Mean of the buffer cells)/(3 * Standard deviation of buffer cells) 

4.  Calculate the detection limit:  
A2 NIST measurement in attomoles/signal-to-noise ratio 
 If the reader is equipped with the low-noise PMT, the detection limit must 

be <= 75 amol to pass. 
 If the reader is equipped with the red-shifted PMT, the detection limit 

must be <= 500 amol to pass. 

To determine which PMT is installed, check the label on the back of 
the reader. #49984 = low-noise PMT; #49721 = red-shifted PMT. 
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Glowell Test 

Materials 

• Glowell, PN GLO-466, formerly available from LUX BioTechology, Ltd. 
(www.luxbiotech.com) 

• Glowell Adapter Plate, available from BioTek, PN 7160006 
• Filter cube PN 8040553, LUM Filter Block, or a filter cube with a plug in 

EX position 1 or 2 and a hole in the corresponding EM position. 
• Gen5 protocols described starting on page 88 

Procedure 

1. If you have not already done so, insert the Glowell (“window” side up) into 
well D8 of the Adapter Plate. 

2. Create an experiment based on the Cytation 5 F-Lum-Test_Glowell.prt or 
Cytation 5 M-LumTest_Glowell.prt protocol, and read the plate. 

3. Calculate and evaluate the results as described on page 87. 

Plate Layout 

  1 2 3 4 5 6 7 8 9 10 11 12 

A                 BUF BUF BUF   

B                 BUF BUF BUF   

C                 BUF BUF BUF   

D               Glowell BUF BUF BUF   

E                 BUF BUF BUF   

F                 BUF BUF BUF   

G                 BUF BUF BUF   

H                 BUF BUF BUF   

Glowell Results Analysis 

1. Locate these items on the Glowell’s Calibration Certificate: Calibration Date, 
Radiant Flux (pW), Measurement Uncertainty of the Radiant Flux. 

2. Calculate the number of days between the Calibration Date and the date the 
test was performed. 

3. Correct the Glowell’s Radiant Flux value for deterioration over time:  
Radiant Flux * (1 – 0.000333 * number of days since calibration) 

4. Convert the Corrected Radiant Flux value to attomoles: 
(Corrected Radiant Flux / 0.021) * 1800 
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5. Calculate an error factor for the Corrected Radiant Flux (amol):  
(Corrected Radiant Flux in amol * Measurement Uncertainty) / 100 

6. Calculate the min/max criteria for the Corrected Radiant Flux (amol): 
MIN: Corrected Radiant Flux in amol – Error Factor  
MAX: Corrected Radiant Flux in amol + Error Factor 

7. Calculate the Signal-to-Noise Ratio:  
Measurement value of the Glowell – Mean of Column 9  
3 x Standard Deviation of Column 9 

8. Calculate the Detection Limit:  
Corrected Radiant Flux in amol/Signal-to-Noise Ratio 

9. Calculate the min/max criteria for the Detection Limit: 
MIN: MIN for Corrected Radiant Flux in amol/Signal-to-Noise Ratio 
MAX: MAX for Corrected Radiant Flux in amol/Signal-to-Noise Ratio 
 If the reader is equipped with the low-noise PMT, the detection limit must 

be <= 75 amol to pass. 
 If the reader is equipped with the red-shifted PMT, the detection limit 

must be <= 500 amol to pass. 

Gen5 Protocol Reading Parameters 

Cytation 5 F-LumTest_Harta.prt 
Parameter Default Setting 

Plate Type: 8030015 Harta - w/o 8032028 adapter 

Delay Step: 3 minutes 

Read Step 1 

Detection Method: Luminescence 

Read Type: Endpoint 

Step Label: "Reference well A2" 

Read Wells: A2 

Filter Sets: 1 (open) 

Excitation: Plug 

Emission: Hole 

Gain: 135 

Integration Time: 0:10.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 7.00 mm 
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Parameter Default Setting 

Read Step 2 

Detection Method: Luminescence 

Read Type: Endpoint 

Step Label: "Background" 

Read Wells: D1..G4 

Filter Sets: 1 (Open) 

Excitation: Plug 

Emission: Hole 

Gain: 135 

Integration Time: 0:10.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 7.00 mm 

Read Step 3 

Detection Method: Luminescence 

Read Type: Endpoint 

Step Label: "Battery Check" 

Read Wells: A7–A8 

Filter Sets: 1 (Open) 

Excitation: Plug 

Emission: Hole 

Gain: 60 

Integration Time: 0:01.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 10.00 mm 
 

Cytation 5 M-LumTest_Harta.prt 
Parameter Default Setting 

Plate Type: 8030015 Harta - w/o 8032028 adapter 

Delay Step: 3 minutes 

Read Step 1 

Detection Method: Luminescence 

Read Type: Endpoint 

Cytation 5  



90 | Instrument Testing  

Parameter Default Setting 

Step Label: "Reference well A2" 

Read Well: A2 

Wavelength 1 

Gain: 150 

Integration Time: 0:10.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 1.00 mm 

Read Step 2 

Detection Method: Luminescence 

Read Type: Endpoint 

Step Label: "Background" 

Read Wells: F1..G12 

Wavelength 1 

Gain: 150 

Integration Time: 0:10.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 1.00 mm 

Read Step 3 

Detection Method: Luminescence 

Read Type: Endpoint 

Step Label: "Battery Check" 

Read Wells: A7–A8 

Wavelength 1 

Gain: 80 

Integration Time: 0:01.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 1.00 mm 
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Cytation 5 F-LumTest_Glowell.prt 

Parameter Default Setting 

Plate Type: Costar 96-well black opaque (#3915) 

Delay Step: 3 minutes 

Detection Method: Luminescence 

Read Type: Endpoint 

Read Wells: A8..H11 

Filter Sets: 1 (Open) 

Excitation: Plug 

Emission: Hole 

Gain: 150 

Integration Time: 0:10.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 7.00 mm 

Cytation 5 M-LumTest_Glowell.prt 

Parameter Default Setting 

Plate Type: Costar 96-well black opaque (#3915) 

Delay Step: 3 minutes 

Detection Method: Luminescence 

Read Type: Endpoint 

Read Wells: A8..H11 

Wavelenths: 1 

Gain: 150 

Integration Time: 0:10.00 MM:SS.ss 

Delay after plate movement: 350 msec 

Dynamic Range: Standard 

Read Height: 1.00 mm 
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Alpha Detection Test 
This section applies only to models with the alpha module. 

For BioTek Service Personnel only: An alternate method for 
conducting this test is to follow the Alpha Laser Calibration instructions in 
the Cytation 5 Service Manual (PN 1321023). This calibration requires the 
use of the EM Mono Efficiency Alpha Jig (PN 7162512 Rev F or higher). 

The alpha laser has been factory-calibrated to meet specification. BioTek 
Instruments, Inc., has developed a test protocol that can be used with Alphascreen 
Omnibeads to verify the functionality of the alpha laser system. Because the detector 
for the alpha system is functionally and optically identical to the luminescence 
system, the luminescence test may be used to verify detector functionality. 

The Crosstalk test is a measure of how well the optical system can distinguish the 
signals emitted from the well being read from those of any adjacent well. This test 
also determines the signal-to-noise ratio (SNR) of the test plate and verifies that the 
signal is at an acceptable level for the sample material used. The test is designed for 
use with Alphascreen Omnibeads, and it is assumed that 96-well plates are used with 
100 µL well volumes. 

Required Materials 

• Recommended test solution, Alphascreen Omnibead Assay kit, available from 
PerkinElmer (PN 6760626) 

• Buffer: Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfg. 
#P4417 or equivalent) 

• Clean 96-well solid white microplate 
• 15-mL conical-bottom, polypropylene sample tube 
• Alpha filter cube 
• Gen5 protocols, described on page 94 

Test Solutions 

Alphascreen Omnibeads are light sensitive. All tests should be performed 
under subdued laboratory lighting of less than 100 lux. 

1. Prepare the PBS buffer solution: 
a. (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of 

deionized or distilled water. 
b. Follow the manufacturer's instructions on the PBS packaging to create 200 

mL, dissolving the necessary amount of PBS into the filtered water. 
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c. Stir the solution (preferably using a stir table) until the PBS is completely 
dissolved. 

d. Check the pH; it should be between 7.2 and 7.6 at 25°C. 
2. Prepare the Omnibead suspension: 

a. Shake the container of 5 mg/mL Omnibead suspension vigorously for 30 
seconds prior to pipetting. Alternatively, sonicate or vortex the container. 

b. Mix 20 µL of 5 mg/mL Omnibead suspension with 4.98 mL of PBS in a 15 
mL conical bottom, polypropylene sample tube. This yields a 20 µg/mL 
Omnibead suspension. 

c. Refrigerate any unused portions of the Omnibeads. The temperature must 
be between +2°C and +6°C. 

Pipette Map 

  1 2 3 4 5 6 7 8 9 10 11 12 

A BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF 

B BUF 
20 

µg/mL  
OMB  

BUF BUF 
20 

µg/mL  
OMB  

BUF BUF 
20 

µg/mL  
OMB  

BUF BUF 
20 

µg/mL  
OMB  

BUF 

C BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF 

D                         

E                         

F                         

G BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF 

H BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF BUF 

Procedure 

Crosstalk Test 

1. Pipette 100 µL of PBS in wells A1–A12, B1, B3–B4, B6–B7, B9–B10, B12, C1–
C12, and G1–H12 (see pipette map, “BUF“ wells). 

2. Pipette 100 µL of 20 µg/mL Omnibead suspension into wells B2, B5, B8, and 
B11 (see pipette map, “20 µg/mL OMB” wells). 

Allow the plate to sit at room temperature for approximately 15 minutes 
prior to use. 

3. Create an experiment based on the Cytation 5 AlphaTest_Crosstalk.prt 
protocol. Read the plate, and then save the experiment. 
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4. Open the Plate menu and export the data to the embedded Power Export 
spreadsheet. The spreadsheet reports pass or fail for the test performed. See 
Results Analysis, next, for descriptions of the calculations and 
troubleshooting tips. 

5. Print the spreadsheets and store them with your test records. 

Results Analysis 

1. Calculate the crosstalk for each of the four wells of Omnibead solution by 
dividing the background-subtracted Mean value of the surrounding adjacent 
wells by the background-subtracted Omnibead suspension well. 

2. Average the % crosstalk of the four test wells to determine level of crosstalk 
(Crosstalk Mean). 

3. Verify that the % crosstalk is less than or equal to 0.1% 
4. Calculate the signal-to-noise ratio (SNR) by using the following equation: 

SNR = (signal mean – background mean)/(SQRT(signal STD² + background STD²)) 
5. Verify that SNR is greater than or equal to 10. 

Troubleshooting Alpha Tests 

If the test fails, please try the following suggestions. If the test(s) continue to fail, 
print the results and contact BioTek’s Technical Assistance Center. 

• Are the solutions fresh? 
• Have the solutions been stored properly (between +2°C and +6°C)? 
• Has the kit been exposed to excessive light (in excess of 100 lux)? 
• If the Crosstalk test continues to fail, the laser may not be firing. Contact BioTek 

TAC. 

Gen5 Protocol Reading Parameters 

The information in the following table represents the recommended reading 
parameters. It is possible that your tests will require modifications to some of these 
parameters, such as Plate Type or Gain value (see Troubleshooting Tips above). 

The Plate Type setting in the Gen5 protocol should match the plate you 
are actually using. 

Cytation 5 AlphaTest_Crosstalk.prt 

Parameter Default Setting 

Plate Type Costar 96-well white opaque 

Detection Method Alpha 

Read Type Endpoint 
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Parameter Default Setting 

Read Wells Full plate 

Gain 120 

Delay after plate movement 0 msec 

Excitation time 100 msec 

Delay after excitation 120 msec 

Integration time 100 msec 

Read height 7.00 mm 

Dispense Module Tests 
This section applies only to models with the dispenser. 

Required Materials 

• Absorbance reader with capability of reading at 405, 630, and 750 nm. The 
reader must have an accuracy specification of ± 1.0% ± 0.010 OD or better and a 
repeatability specification of ± 1.0% ± 0.005 OD or better. 

The Cytation 5 may be used if it is equipped with absorbance 
capabilities and has passed the Absorbance Plate Test or Absorbance 
Liquid Test 1. 

• Microplate shaker (if the absorbance reader does not support shaking) 
• Precision balance with capacity of 100 g minimum and readability of 0.001 g 
• 50–200 µL hand pipette and disposable tips 
• Deionized water 
• Supply bottles 
• 250-mL beaker 
• New 96-well, clear, flat-bottom microplates 
• BioTek’s Green Test Dye Solution (PN 7773003) undiluted, or one of the 

alternate test solutions listed in the next section 
• 100-mL graduated cylinder and 10-mL pipettes (if not using BioTek’s Green 

Test Dye Solution) 
• Gen5 software installed on the host PC 
• Gen5 protocols described on page 98 
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Alternate Test Solutions 

80 µL of test solution with 150 µL of deionized water should read between 
1.300 and 1.700 OD at 405/750 nm. The solutions should be at room 
temperature. 

If you do not have BioTek’s Green Test Dye Solution (PN 7773003), prepare a dye 
solution using one of the following methods. 

Using BioTek’s Blue and Yellow Concentrate Dye Solutions: 

Ingredient Quantity 

Concentrate Blue Dye Solution (PN 
7773001, 125 mL) 4.0 mL 

QC (Yellow) Solution (PN 7120782, 125 mL) 5.0 mL 

Deionized water 90.0 mL 

Using FD&C Blue and Yellow Dye Powder: 

Ingredient Quantity 

FD&C Blue No. 1 0.200 grams 

FD&C Yellow No. 5 0.092 grams 

Tween 20 1.0 mL 

Sodium Azide N3Na 0.100 gram 

Deionized water Make to 1 liter 

Procedure 

The Cytation 5 Operator’s Manual contains the procedure for models 
without absorbance capabilities. 

1. If you have not already done so, create the Gen5 protocols Cytation 5 Disp 1 
Test.prt and Cytation 5 Disp 2 Test.prt, starting on page 98. 

2. Prime both dispensers with 4000 µL of deionized or distilled water. 
3. Purge both dispensers with the Volume set to 2000 µL. This prevents the 

water from diluting the dye. Remove the inlet tubes from the supply bottles.  
4. Fill a beaker with at least 20 mL of the green dye solution. Prime both 

dispensers with 2000 µL of the solution. When finished, remove the priming 
plate from the carrier. 

5. In Gen5, create an experiment based on Cytation 5 Disp 1 Test.prt. 
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6. Place a new 96-well microplate on the balance and tare the balance. 
7. Place the plate on the microplate carrier. 

 
Running a dispense procedure without placing a plate in the reader will result in 
contamination of the reader from spilled liquid. 

When each dispense step is finished, you will weigh the plate, 
record the weight, tare the balance with the plate on it, and then 
place the plate back on the carrier for the next step. 

8. Select Plate > Read and click READ. Gen5 prompts you to empty the tip 
priming trough. 

9. When ready, click OK at the Load Plate dialog to begin the experiment. The 
sequence is as follows: 

a. Dispense 80 µL/well to columns 1–4. 
b. Remove the plate and weigh it. Record the weight and tare the balance. 
c. Place the plate on the carrier and dispense 20 µL/well to columns 5–8. 
d. Remove the plate and weigh it. Record the weight and tare the balance. 
e. Place the plate on the carrier and dispense 5 µL/well to columns 9–12. 
f. Remove the plate and weigh it. Record the weight. 
g. Manually pipette 150 µL of deionized or distilled water into all 12 

columns, on top of the green test dye solution. 
h. Place the plate on the carrier for a 15-second shake, the “80 µL” read at 

405/750 nm, and the “20 and 5 µL” read at 630/750 nm. 

10. When processing is complete, save the file with an identifying file name. 
11. Remove the plate from the carrier and set it aside. 
12. Repeat steps 5–11 using Cytation 5 Disp 2 Test.prt. 
13. See the instructions for analyzing the results below. 
14. When all tests are complete, prime both dispensers with at least 5000 µL of 

deionized water to flush out the green dye solution. 

Results Analysis 

The pass/fail criteria for each set of 32 wells with the same dispense volume is based 
on the calculated coefficient of variation (% CV) and Accuracy % Error. 

For each volume dispensed (80 µL, 20 µL, 5 µL), for each dispenser (1, 2): 

• Calculate the Standard Deviation of the 32 wells 
• Calculate the Mean of the 32 wells 
• Calculate the %CV: (Standard Deviation / Mean) x 100 
• Calculate the Accuracy % Error:  

((Actual Weight – Expected Weight)/Expected Weight)* 100 
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Expected Weights for 32 wells: 80 µL (2.560 g), 20 µL (0.640 g), 5 µL 
(0.160 g). It is assumed that one gram is equal to one milliliter. 

Dispense Volume To pass, %CV must be To pass, Accuracy %  
Error must be: 

80 µL ≤ 2.0% ≤ 2.0% 

20 µL ≤ 7.0% ≤ 5.0% 

5 µL ≤ 10.0% ≤ 20.0% 

Gen5 Test Protocols for Models with Absorbance Capabilities 

Perform the steps in the following sections to create two protocols for testing 
Dispensers 1 and 2. When finished, save the files as Cytation 5 Disp 1 (and 2) 
Test.prt. 

Define the Procedure 

The protocol’s procedure follows the sequence below. After each dispense step, the 
plate is ejected to allow the operator to weight it and then tare the balance. 

• Dispense 80 μL dye to columns 1–4  
• Dispense 20 μL dye to columns 5–8  
• Dispense 5 μL dye to columns 9–12  
• Shake the plate for 15 seconds  
• Read columns 1–4 at 405/750 nm, calculate the Delta OD  
• Read columns 5–12 at 630/750 nm, calculate the Delta OD  

The detailed procedure is described on the next page. To add a step to the procedure, 
click the appropriate button on the left side of the Procedure dialog and define the 
required parameters.  

The comments suggested for use with the Plate Out/In steps are optional. 

Gen5 Procedure Steps 

# Step 
Type Details 

1 Dispense 

Dispenser <select 1 or 2, depending on the protocol>  
Dispense to wells A1..H4  
Tip prime before this dispense step, 20 µL  
Dispense 80 µL at rate 275 µL/sec  

2 Plate Suggested comment: Weigh the plate (80 uL test). RECORD the 
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Gen5 Procedure Steps 

# Step 
Type Details 

Out,In weight, TARE the balance. Place the plate back on the carrier. Click 
OK to continue. 

3 Dispense 

Dispenser <select 1 or 2, depending on the protocol>  
Dispense to wells A5..H8  
Tip prime before this dispense step, 20 µL  
Dispense 20 µL at rate 250 µL/sec  

4 Plate 
Out,In 

Suggested comment: Weigh the plate (20 uL test). RECORD the 
weight and TARE the balance. Place the plate back on the carrier. 
Click OK to continue. 

5 Dispense 

Dispenser <select 1 or 2, depending on the protocol>  
Dispense to wells A9..H12  
Tip prime before this dispense step, 5 µL  
Dispense 5 µL at rate 225 µL/sec  

6 Plate 
Out,In  

Suggested comment: Weigh the plate (5 uL test). RECORD the 
weight. PIPETTE 150 uL/well of DI water into all 12 columns. Place 
the plate back on the carrier. Click OK to perform the Read steps. 

7 Shake Linear at 567 cpm (3 mm) for 15 seconds 

8 Read 

Step label: “80 ul Read_Disp 1” (or _Disp 2)  
Wells: A1..H4  
Detection Method: Absorbance  
Read Type: Endpoint  
Read Speed: Normal  
Two Wavelengths: 405 and 750 nm  

9 Read 

Step label: “20 and 5 ul Read_Disp 1” (or _Disp 2)  
Wells: A5..H12  
Detection Method: Absorbance  
Read Type: Endpoint  
Read Speed: Normal  
Two Wavelengths: 630 and 750 nm  

Add Data Reduction Steps  

Each Read step is performed using two wavelengths. Create two data reduction steps 
to calculate the Delta OD values.  

1. Select Protocol > Data Reduction and select Custom.  
2. Within this dialog, click Select Multiple Data Sets and then click DS2.  
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• Set the Data In for DS1 to the 80 μl Read step at 405 nm.  
• Set the Data In for DS2 to the 80 μl Read step at 750 nm.  

3. Click OK to return to the dialog.  
4. In the New Data Set Name field, type an identifying name such as ‘Delta OD 

80 ul_Disp 1’.  
5. Clear Use single formula for all wells.  
6. In the Current Formula field, type DS1-DS2 and then assign the formula to 

wells A1 to H4.  
7. Click OK to add the transformation to the Data Reduction list.  
8. Create another Transformation similar to the above, with these 

characteristics:  
• DS1 set to the 20 and 5 μL Read step at 630 nm  
• DS2 set to the 20 and 5 μL Read step at 750 nm  
• New Data Set Name resembling ‘Delta OD 20 and 5 ul_Disp <#>’  
• Formula DS1-DS2 applied to wells A5 to H12  
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General Specifications 
Microplates 

The Cytation 5 accommodates standard 6-, 12-, 24-, 48-, 96-, and 384-well 
microplates with 128 x 86 mm geometry, 1536-well plates (for imaging only), 
Take3 and Take3 Trio Micro-Volume Plates, microplate slides, T25 cell culture flasks 
(with adapter), and 35 mm, 60 mm, and 100 mm Petri dishes (with adapter). 
Maximum Plate Height: 1.0" 

Hardware and Environmental 
Light Source   

Absorbance, Fluorescence 
(FI), monochromator-based: 

Xenon flash light source, 20W maximum average 
power (not user-changeable) 

Fluorescence (FI/FP), filter-
based: 

Xenon flash light source, 5W maximum average 
power (not user-changeable) 

TRF (filter-based): Xenon flash light source, 5W maximum average 
power (not user-changeable) 

Dimensions: 20.25" D x 15.50" W x 17.5" H  
51.4 cm D x 39.4 cm W x 44.5 cm H  

Weight: With all modules installed, without power supply or 
dispense module attached, < 80 lbs. (36.3 kg) 

Environment: 

Power-up temperature 18ºC to 30ºC (64.4ºF to 
86ºF) 
Note: Performance measurements, including 
detection limits, were verified up to 25ºC (77ºF). 

Humidity: 10% to 85% relative humidity (non-condensing) 

Power Supply: 24-volt external power supply compatible with 100–
240 V~; +/-10% @50–60 Hz  

Power Consumption: 130W maximum 

Incubation: 

Temperature control ranges from 4ºC over ambient 
to 65ºC.  
Temperature variation ± 0.5ºC across the plate @ 
37ºC, tested with Innovation Instruments, Inc. 
temperature test plate  
Top and bottom incubation controlled via software-
adjustable gradient. 
For models with the alpha laser module: Alpha 
laser module operation is disabled above an internal 
instrument temperature of 35ºC. 
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Plate Shaking 

Linear: 

Amplitude: 1 mm to 6 mm in 1-mm steps  

Frequency*: ~18 Hz to ~6 Hz  

Orbital Slow:  

Amplitude: 1 mm to 6 mm in 1-mm steps  

Frequency*: ~10 Hz to ~3 Hz  

Orbital Fast:  

Amplitude: 1 mm to 6 mm in 1-mm steps  

Frequency*: ~14 Hz to ~5 Hz  

Double Orbital Slow:  

Amplitude: 1 mm to 6 mm in 1-mm steps  

Frequency*: ~10 Hz to ~3 Hz  

Double Orbital Fast:  

Amplitude: 1 mm to 6 mm in 1-mm steps  

Frequency*: ~14 Hz to ~5 Hz  

* Frequency is based on the amplitude selected. 
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Dispense/Read Specifications 
Maximum Delay between End of Dispense and Beginning of Read 
96/384-well plates, default probe heights 

Bottom Mono Fluorescence T ≤ 0.5 second 

Luminescence T ≤ 0.5 second 

Top Filter Fluorescence T ≤ 1.0 second 

Top Mono Fluorescence T ≤ 1.0 second 

Absorbance T ≤ 1.0 second 

 
Dispense/Read, for models with the dual-reagent dispense module 

Plate Type Both injectors dispense to standard height 6-, 12-, 24-, 48-, 96-, 
and 384-well microplates. 

Detection Method Absorbance, Fluorescence (FI, FP, TRF), Luminescence, Imaging 
(well mode only) 

Volume Range 5–1000 µL with a 5–20 µL tip prime 

Reagent Dead 
Volume < 1100 µL, with dead volume recovery function (back flush)  

Injection Speeds 225, 250, 275, 300 µL/second 

Accuracy ± 1 µL or 2.0%, whichever is greater  

Precision 

≤ 2.0% for volumes of 50–200 µL  

≤ 4.0% for volumes of 25–49 µL  

≤ 7.0% for volumes of 10–24 µL  

≤ 10.0% for volumes of 5–9 µL  
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Absorbance Specifications 
Optics 

Wavelength Range 230 to 999 nm 

Wavelength Bandpass < 4 nm (230–285 nm), < 8 nm (> 285 nm) 

Measurement Range 0.000 to 4.000 OD 

Resolution 0.0001 OD 

Increment 1 nm 

Wavelength Accuracy ± 2 nm  

Wavelength Precision ± 0.2 nm  

Minimum kinetic interval (450 nm) ≤ 20 seconds, sweep mode, 96-well microplate 

 
Plate In/Plate Out Speed 

≤ 35 seconds, 450 nm, sweep mode, 96-well microplate 

 
Accuracy, Linearity, Repeatability 

Specifications apply from 250–999 nm, 200 µL (96-well microplates)  

Accuracy (tested with certified neutral density glass) 

96-well plate, normal read speed 

0–2 OD: +/-1% +/-0.010 OD, delay after plate movement = 100 ms  

2–2.5 OD: +/-3% +/-0.010 OD, delay after plate movement = 100 ms  

384-well plate, normal read speed  

0–2 OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms  

2–2.5 OD: +/-5% +/-0.010 OD, delay after plate movement = 100 ms  

96-well and 384-well plate, sweep read speed  

0–1 OD: +/-1% +/-0.010 OD  

Cytation 5  



106 | Specifications  

Accuracy, Linearity, Repeatability 

Linearity (by liquid dilution) 

96-well plate, normal read speed  

0–2 OD: +/-1% +/-0.010 OD, delay after plate movement = 100 ms  

2–2.5 OD: +/-3% +/-0.010 OD, delay after plate movement = 100 ms  

384-well plate, normal read speed  

0–2 OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms  

2–2.5 OD: +/-5% +/-0.010 OD, delay after plate movement = 100 ms  

96-well and 384-well plate, sweep read speed  

0–1 OD: +/-1% +/-0.010 OD  

Repeatability (tested with certified neutral density glass/measured by one 
standard deviation: 8 measurements per data point) 

96-well and 384-well plate, normal read speed  

0–2 OD: +/-1% +/-0.005 OD, delay after plate movement = 100 ms  

2–2.5 OD: +/-3% +/-0.005 OD, delay after plate movement = 100 ms  

96-well and 384-well plate, sweep read speed  

0–1 OD: +/-2% +/-0.010 OD 

 
Take3 Plate 

Detection Limit, 260 nm dsDNA < 5 ng/µL 
 

BioTek Instruments, Inc. 



Fluorescence Specifications (Mono-Based) | 107 

 

Fluorescence Specifications (Mono-Based) 
The Cytation 5 measures fluorescence with monochromators from the top and 
bottom of 6- to 384-well plates. All detection limit (DL) requirements are measured 
by the “two-point” method, which gives the limit of detection at a signal-to-noise 
ratio of one where noise is defined as three times the standard deviation of the 
background wells. 

Monochromator-Based Fluorescence 

Excitation range 
250–700 nm with low-noise PMT 

250–900 nm with red-shifted PMT 

Emission range 

250–700 nm with low-noise PMT 

300–700 nm for emission scans with low-noise PMT 

250–900 nm with red-shifted PMT 

300–900 nm for emission scans with red-shifted PMT 

Selectable increment 1 nm 

Bandpass  Variable from 9 nm to 50 nm in 1 nm increments (both 
excitation and emission) 

Minimum kinetic 
interval < 20 seconds, sweep mode, 96-well microplate 

 
Plate In/Plate Out Speed 

≤ 35 seconds, sweep mode, 96-well microplate 

 
Sensitivity 

Sodium Fluorescein in phosphate buffered saline (PBS) 
DL ≤ 20 pM top or bottom read, 5 pM typical 
Excitation 485 nm, Emission 528 nm 
Methylumbelliferone (MUB) in carbonate-bicarbonate buffer (CBB) 
DL ≤ 0.16 ng/mL (0.91 nM) top read 
Excitation 360 nm, Emission 460 nm 
Propidium Iodide (PI) in PBS 
DL ≤ 62.5 ng/mL bottom read 
Excitation 485 nm, Emission 645 nm 
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Fluorescence Specifications (Filter-Based) 
The Cytation 5 measures fluorescence with filters from the top of 6- to 384-well 
plates.  

Plate In/Plate Out Speed 

≤ 35 seconds for filter set, sweep mode, 96-well microplate 

 
Fluorescence Intensity 

DL ≤ 10 pM (3 pM typical) solution of Sodium Fluorescein in PBS Excitation 485/20, 
Emission 528/20, 510 nm mirror  

DL ≤ 0.16 ng/mL (0.91 nM typical) solution of Methylumbelliferone in CBB, 
Excitation 360/40, Emission 460/40, 400 nm mirror  

 
Time-Resolved Fluorescence 

DL Europium ≤ 250 fM (100 fM typical) 

Excitation 360/40 nm, Emission 620/40 nm, 400 nm mirror  

Integration time 20 to 2000 µs 
Delay 0 to 2000 µs 
Granularity 1-µs step 

 

 
Fluorescence Polarization 

5 mP standard deviation at 1 nM Sodium Fluorescein  

Excitation 485/20 nm, Emission 528/20 nm, 510 nm mirror  

Excitation range: 400 to 700 nm  

Emission range: 400 to 700 nm  
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Luminescence Specifications 
The Cytation 5 measures luminescence from the top of 6- to 384-well plates. The 
following requirements apply to 96-well plates with 200 µL/well, at room 
temperature. Production testing is performed using a Harta plate. 

Luminescence 

DL ≤ 75 amol/well, 30 amol typical with low-noise PMT 
≤ 500 amol/well with red-shifted PMT 

Integration Time 10 seconds 

Gain 150 

Blank Wells 16 

Imaging Specifications 
The Cytation 5 imaging specifications are based on using an NIH 3T3 plate: 10,000 
wells per cell, GFP stain, Costar 3603 black-sided, plastic-bottom plate. 

Read Speed 

At 20X, Autofocus on, 96-well plate, 1 image per well < 10 minutes 
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